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DIABLO ANALYTICAL, INC. SOFTWARE LICENSE AGREEMENT AND LIMITED WARRANTY 

 

LICENSE AGREEMENT 

 

IMPORTANT:  Please carefully read the License Agreement below before installing the software.  The right to use this 

software product is sold only on the condition that the customer agrees to the following license.  INSTALLING THE 

SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. 

 

In return for payment of the one-time license fee for this software product, Customer receives from Diablo Analytical, 

Inc. (Diablo) a license to use the product subject to the following terms and conditions: 

 

Use:  The product may be used one computer or workstation.  A separate license agreement and fee is required for each 

additional computer or workstation on which the product is used.  Customer may not reverse assemble, decompile, or 

modify the software. 

 

Copies:  The software product may not be duplicated or copied except for archive purposes, program error verification, 

or to replace defective media, and all copies made must bear the copyright notices contained in the original. 

 

Ownership:  Purchase of this license does not transfer any right, title or interest in the software product to Customer 

except as specifically set forth in this License Agreement.  Customer is on notice that the software product is protected 

under copyright laws. 

 

Transfer of  Rights:  This license and the software product may be transferred to a third party, with prior written consent 

from Diablo, provided the third party agrees to all the terms of this License Agreement and the Customer does not retain 

any copies of the software product. 

 

Sublicensing and Distribution:  Customer may not sublicense the software or distribute copies of the software to the 

public in physical media or by telecommunication without the prior written consent of Diablo. 

 

Termination:  Diablo reserves the right to terminate this license upon breach.  In event of termination, Customer will 

either return all copies of the product to Diablo, or with Diablo's prior consent, provide Diablo with a certificate of 

destruction of all copies. 

 

Updates and Upgrades:  Customer agrees that the software does not include updates and upgrades which may be 

available from Diablo in a separate support agreement. 

 

Export Restrictions:  Customer agrees not to export or re-export the software or any copy in violation of the U.S. Export 

Administration regulations or other applicable regulation. 

 

LIMITED WARRANTY 

 

Limited Warranty:  Diablo warrants that the original disks are free from defects for 90 days from the date of delivery of 

the software. 

 

No Other Warranties:  To the maximum extent permitted by applicable law, Diablo expressly disclaims any warranty for 

the software product.  The software product and any related documentation is provided "as is" without warranty of any 

kind, either express or implied, including, without limitation, the implied warranties or merchantability of fitness for a 

particular purpose.  The entire risk arising out of use or performance of the software product remains with the customer. 

 

Limitation of Liability and Customer Remedies:  Diablo's entire liability and the customer's exclusive remedy under this 

license agreement shall be, at Diablo's option, either (a) return of the price paid for the software or (b) replacement of the 

software that does not meet Diablo's Limited Warranty and which is returned to Diablo with a copy of the customer's 

receipt.  Any replacement software will be warranted for the remainder of the original warranty period, or 30 days, 

whichever is longer.  These remedies are not available outside the United States of America. 

 



 

 

No Liability for Consequential Damages:  To the maximum extent permitted by applicable law, in no event shall Diablo 

be liable for any damages whatsoever (including, without limitation, damages for loss of business profit, business 

interruption, loss of business information, or any other pecuniary loss) arising out of the use or inability to use the 

product, even if Diablo has been advised of the possibility of such damages.  Because some states/jurisdictions do not 

allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply 

to you. 
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Introduction 

EZReporter Software Overview 

Advanced Post-run Reporting and Analysis for Chromatography Data 
Systems. 

EZReporter is a flexible, advanced post-run analysis and reporting solution for a 

number of supported chromatography data systems. 

 
The Diablo Analytical EZReporter Software 
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The EZReporter software includes a base reporting module and three optional 

modules: a Natural Gas Analysis (NGA) calculation and reporting module, a Results 

Database module, and an Analog & Digital Output module used with the National 

Instruments Compact FieldPoint hardware.  These modules are combined in several 

different “Editions” of the EZReporter software. 

 

EZReporter Edition Modules Included 

Standard Edition Base Module Only 

Natural Gas Analysis Edition Base and Natural Gas Analysis Modules 

Results Database Edition Base and Results Database Modules 

NGA Database Edition Base, NGA, and Results Database Modules 

Analog and Digital Output Edition Base and Analog & Digital Output Module 

The Base Module is required for all Editions of the software.  You can also license 

and activate individual Modules at a later time if your needs change.  The features 

included in each module are summarized below. 

Base Software Module 

The Base software module can be licensed by itself or you can add one or both of the 

optional modules.  The features present in the base module include: 

 Process Results Automatically from supported chromatography 

data systems 

 Multi-Channel Reporting: Results from multiple detector channels 

can be combined into a single report with both raw and normalized 

amounts displayed. 

 Easily Updated and Customized:  The component list is completely 

customizable.  Components can be added to or deleted from the 

component list. 

 Data Export: Results can be exported to a text file for transfer to a 

Laboratory Information Management System (LIMS), Process Control 

System, or even Microsoft Excel.  The format of the text file can be 

easily customized using EZReporter’s flexible Export Templates. 

 Monitor Specific Results:  You can set up both component and 

calculated results as monitored parameters that are displayed in a 

separate monitoring window. 

 High and Low Alarms:  You can set both high and low alarm limits 

for monitored parameters. 

 Trend/History Plots:  You can plot the historical value of any of the 

monitored parameters.  The trend plot can be printed, copied to the 

Windows clipboard, and the historical data can be exported to a 

comma-delimited text file. 

 Include Results from Other Analyzers:  The component list can be 

configured so that results from other analyzers can be entered manually 

for specified components and included in the reports. 

 

Optional Natural Gas Analysis Module 

The optional Natural Gas Analysis (NGA) module is designed to perform Natural 

Gas / Refinery Gas / Natural gas Liquids (NGL) heating value and related 
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calculations.  The results from these calculations are available for reporting, 

monitoring, trend plotting, and exporting through the base module.   The features 

present in the NGA module include: 

 Standard GPA/ASTM/ISO Calculations:  Calculates 

Dry/Saturated/Wet Gross and Net Heating Value, Real Relative 

Density, Gas Compressibility factor, GPM value, Wobbe Index, and a 

large number of other results using GPA 2172-09, 2177-03, 2186-02, 

ASTM D2598-02 (vapor pressure and relative density), and ISO 6976 

standard calculations. 

 Physical Properties can be Easily Customized:  The component list 

is completely customizable.  Components can be added to or deleted 

from the component list, and calculation factors (Heating Value, Molar 

Mass Ratio, Summation Factor, and GPM Volume Factor, etc.) can be 

updated by the user as needed. 

 Standard Physical Property Tables:  Standard component physical 

property tables are provided for: 

 the GPA 2145-03 and GPA 2145-09 Standards 

 the GPSA Engineering Data Book (12th Edition, 2004) 

 the ASTM D3588-98 (2003) standard 

 the GPA TP-17 Standard 

 the ASTM D2598-02 (2007) standard (vapor pressure and relative 

density) 

 the ISO 6976 Standard 

Optional Results Database Module 

The optional Results Database module allows you to capture results and save them in 

a local SQLite database.  A few of the capabilities of the Results Database are listed 

below. 

 Local “Zero Configuration” Database:  Sample results including 

sample information, individual component results, and calculated 

natural gas analysis (NGA) results can be added automatically to a 

local results database. 

 Search for Results:  You can search the results database for historical 

results by Sample Name or Results ID.  Results can be filtered further 

by Injection or Report Date and Results or Export Status. 

 Batch Processing:  You can batch reprocess multiple results from the 

database.  Reprocessing options include printing reports, exporting 

results, and trend-plotting results. 

 Statistical Analysis:  Statistics including average, standard deviation, 

%RSD, maximum, and minimum are calculated and displayed when 

performing sample name searches. 

 Compare Results: A results comparison window can be used to 

compare the component normalized mole% values between two 

samples using either the GPA 2261 repeatability or reproducibility 

limits (or any other limits entered by the user). 

 Track Result Status:  Each result in the database has a “Status” field 

that can be set to “None”, “Accept”, or “Reject” status.  The status field 
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can then be used in searches or batch reprocessing to filter which 

results are selected. 

 Import Results:  You can import results into the Results Database 

from comma- or tab-delimited text files. 

Optional Analog and Digital Output Module 

The EZReporter Analog and Digital Output Module allows you to generate 

analog/signal outputs and digital/alarm outputs based on Monitored Parameter results 

using National Instruments Compact FieldPoint I/O hardware.  See the Analog and 

Digital Output Module Quick Start Guide for information on the Compact FieldPoint 

hardware requirements and the capabilities of this optional module. 

Notes for BTU Calculator Users 

The Diablo EZReporter Software is the next-generation of the Diablo BTU 

Calculator Software.  The EZReporter Natural Gas Analysis (NGA) Edition is the 

direct replacement for the BTU Calculator software.  Existing licenses of the BTU 

Calculator can be upgraded to the EZReporter NGA Edition. 

System Requirements 

The software is designed for operation under the Microsoft Windows 7 Professional 

and Windows XP Professional operating systems.  See the EZReporter Quick Start 

Guide for your chromatography data system for any special requirements. 

 

Important: Important:  It is the customer’s responsibility to set up the Gas Chromatograph and 

chromatography data system so that calibrated peak results are produced from the 

analysis. 

 

Installing the Software 
To install the software, simply run the installation program that was downloaded 

from our web site or provided on the installation CD-ROM.  Follow the directions 

presented by the installation program.  The installation program will install the 

Diablo EZReporter in trial mode on new systems, or will update licensed 

installations to the latest version of the software. 

 

Important: Important:  You must be logged in to an account with Administrator privileges in 

order to install the software. 

Important:  Any users who will be running the software under a non-administrator 

account must have full read/write permissions to the EZReporter directories and 

files.  The installation program grants these rights to the “Everyone” user group.  

However, if the “Everyone” user group is disabled on the network, then you will 

have to grant these permissions manually. 

 

 

Installation Paths and Folders 

The EZReporter software is installed to the folder, 
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“C:\Program Files\Diablo EZReporter” (Win XP and Win 7-32 bit) 

“C:\Program Files (x86)\Diablo EZReporter” (Win 7-64 bit) 

EZReporter configuration and template files are saved in the “Settings” folder, 

“C:\Program Files\Diablo EZReporter\Settings” (Win XP and Win 7-32 bit) 

“C:\Program Files (x86)\Diablo EZReporter\Settings” (Win 7-64 bit) 

EZReporter data files are saved by default in the “Data” folder, 

“C:\Program Files\Diablo EZReporter\Data” (Win XP and Win 7-32 bit) 

“C:\Program Files (x86)\Diablo EZReporter\Data” (Win 7-64 bit) 

Upgrading from the Diablo BTU Calculator 
Software 

The EZReporter Natural Gas Analysis (NGA) Edition replaces the BTU Calculator 

software and can read existing BTU Calculator configuration and data files directly. 

The EZReporter installer doesn't touch an existing BTU Calculator installation - the 

two programs can be installed and run on the same computer. 

Automatic Import of Configuration and Template Files 

The first time you start EZReporter, the software will attempt to import any custom 

(non-default) configuration or export template files from the BTU Calculator 

installation folder.  It will also edit the imported configuration files so that the default 

data directory and/or export directory no longer point to their old location in the 

BTU Calculator folder structure (if that is where they were set).  The original files 

are not modified by the import procedure. 

Configuration and template files are now kept in the "Settings" folder under the 

EZReporter installation folder in order to reduce clutter in the main installation 

folder and make it easier to find these files. 

Changes to Chromatography Data System Methods 

You may need to update your chromatography data system methods in order to have 

them use EZReporter instead of the BTU Calculator for automatic processing.  See 

the EZReporter Quick Start Guide for your data system for more information. 

Software License and Registration 

The EZReporter software is distributed as a fully functional 30-day trial application.  

The trial version has all of the features of the registered version, but you will be 

reminded that you are running the trial version with a “nag” screen each time you 

start the software.  At the end of the 30-day trial period the application will no longer 

start unless you purchase a license or request an evaluation extension from Diablo 

Analytical. 

 

Important: Important:  The Results Database, Natural Gas Analysis (NGA), and Analog & 

Digital Output Modules are add-on options that require payment of additional license 

fees and require separate license activation codes (unless they are included in the 

particular software edition that you have licensed).  However, you can evaluate these 

features during the 30-day trial period of the base software.  If you activate the base 

software without also activating the optional module, then those features from the 

un-activated module will be disabled. 
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Activating your License 

Please refer to the Diablo Software License Guide for information on how to activate 

the base EZReporter module or any of the optional modules.  This guide can be 

accessed through the “Help” button on the License Status window that is displayed 

when you start the software or by selecting the “License Status” option of the “Help” 

menu.  An Adobe Acrobat (PDF) version of the guide is also saved in the 

EZReporter installation folder. 

 
The EZReporter “License Status” window used to activate the software. 

Technical Support 

The Diablo EZReporter software was written and is supported by: 

Diablo Analytical, Inc. 
5141 Lone Tree Way 

Antioch, CA  94531 

Phone:  (925) 755-1005 

Fax:    (925) 755-1007 

 

Phone 

If you want to speak directly with technical support, call us at (925) 755-1005. 

 

Fax 

Fax a description of your problem or suggestion to us at (925) 755-1007. 

 

Electronic Mail 

Use our dedicated support address for e-mail based technical support: 

support@diabloanalytical.com 
 

mailto:support@diabloanalytical.com
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World Wide Web 

Use our web-based help desk to submit and track support requests:  

http://www.diabloanalytical.com/support.htm 

Natural Gas Analysis Calculations 

The calculations used in the Natural Gas Analysis module are based on the GPA 

2172-09 Standard, the GPA 2186-02 Standard for Natural Gas Liquids (NGL) 

calculations, and the ISO 6976 Standard.  The physical properties used in the 

calculations can be chosen and/or modified by the user.  However, the software 

includes example configuration files and standard component physical property 

tables from a number of different data sources including GPA 2145-09 and ISO 

6976. 

Special Considerations for the ISO 6976 Standard 

The ISO 6976 Standard includes physical properties for a number of different 

combustion and metering temperatures.  The description of the standard physical 

property data source for the ISO data is of the form, “ISO 6976 (1995) at 25/20 Deg. 

C”, where the first temperature is the combustion temperature (25 Deg. C in this 

example) and the second temperature is the metering temperature (20 Deg. C in this 

example). 

Important: Important:  If you upgrade or re-install the EZReporter Software, all of the default 

configuration files will be overwritten with the current versions.  Consequently, if 

you use any of the default configuration files as the basis for a custom configuration, 

make sure to save your configuration file with a different file name. 

 

See “Natural Gas Analysis” on page 54 for more information on configuring 

EZReporter for Natural Gas Analysis. 

Disclaimer 

 

Important: Important:  It is the customer’s responsibility to ensure that the physical properties 

and other settings in the EZReporter configuration generate results that are correct 

for their application. 

 

The choice of which physical property values to use is a business decision that can 

only be determined by you and your use of the data and results. 

Please review the License Agreement and Limited Warranty displayed at the 

beginning of the printed manual for Diablo’s limits on liability. 

Pressure Base 

All of the default configuration files use a Pressure Base of 14.696 or 14.73 psia.  It 

is the customer’s responsibility to determine the correct Pressure Base to use for their 

specific requirements.  Note that the North American Energy Standards Board 

(NAESB) specifies a standard pressure base of 14.73 psia.  Consequently many 

companies are adopting 14.73 as the standard pressure base for these calculations.  

The ISO default configuration files all use a Pressure Base of 101.325 kPa. 

http://www.diabloanalytical.com/support.htm
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Rounding 

Normalized mole percent values are rounded to the number of decimal places 

specified in the Calculation Settings tab of the configuration editor (see “Component 

Amount Precision” on page 28).  If rounding causes the total normalized mole% not 

to sum to 100%, then a correction is made to the normalized mole% of the most 

concentrated component in the sample (usually methane for NGA applications) to 

force the total to 100%. 

Water Calculations 

If water exists as a component in the component list, then "Saturated" results will be 

calculated using the base temperature (60 degrees F) and pressure and reported along 

with the "Dry" results.  If you enter the water content manually so that the mole% of 

water is greater than 0, then "Wet" results will also be calculated based on that 

mole% value.  You can also choose to calculate the water content correlation based 

on the actual flowing temperature and pressure.  If you enable this option, then “Wet 

(flowing)” results will be reported instead of “Wet” results. 

Note: in the case of configuration files that are based on the ISO 6976 standard, the 

water vapor pressure used in the calculation of saturated results is based on the 

metering temperature for the physical property data being used. 

See “Component Settings for Natural Gas Analysis” on page 54 for more 

information on setting up the component list to include water, and “Water Settings 

for "Saturated" and "Wet" Calculations” on page 60 for information on setting up 

water-related calculation factors. 

 

Important: Important:  All NGA calculations assume that the compositional analysis was 

performed on a dry basis.  The component mole fractions from the dry analysis and 

calculated results are corrected for the water mole fraction when performing the 

saturated and wet calculations. 

 

Disabling NGA Calculations 

The Natural Gas Analysis calculations can be disabled if you want to use the 

software only for general reporting and exporting of analysis results.  See “Disable 

Natural Gas Analysis Calculations and Reporting” on page 58 for more information. 

Resources 

Gas Processors Association 

6526 East 60th Street 

Tulsa, Oklahoma  74145 

Phone:   918-493-3872 

Web:  www.gasprocessors.com 

 

ASTM International 

100 Barr Harbor Drive 

PO Box C700 
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West Conshohocken, PA  19428-2959 

Phone:  610-832-9585 

Web:  www.astm.org 
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Getting Started 

The Sample Results Window 

After starting the software, the following window is displayed.  This window shows 

the “Sample Results” tab containing the results of the last analysis (but will be blank 

when the software is first started). 

 

The “Sample Results” tab on the Main Screen of the Diablo EZReporter Software 
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Sample Information 

This section of the main screen contains the sample information that was passed to 

the software from the chromatography data system, or was entered by the user during 

manual processing.  You can also define custom sample information fields if you 

would like to include additional data in the report.  See “Sample Info” on page 33 for 

more information on this capability. 

Note:  Blank sample information fields are not displayed in the sample Information 

table. 

Component Summary 

This section contains a summary of the individual component results including, 

 Component Peak Retention Time 

 Component Peak Area  

 Component Raw Amount 

 Component Normalized Amount 

NGA Edition: 

 Component Normalized Mole% 

 Component Normalized Weight% 

 Component Normalized Liquid Volume% 

 Component Gross Heating Value (BTU / ideal cu. Ft.) or Superior 

Calorific Value (MJ / m^3) on a volumetric basis 

 Component Gross Heating Value (BTU/lbm) or Superior Calorific Value 

(MJ / kg) on a mass basis 

 Component Gross Heating Value (BTU/gal.) 

 Component Superior Calorific Value (kJ / mol) on a molar basis 

 Component Net Heating Value (BTU/ideal cu. ft.) or Inferior Calorific 

Value (MJ / m^3) on a volumetric basis. 

 Component Net Heating Value (BTU/lbm) or Inferior Calorific Value 

(MJ / kg) on a mass basis 

 Component Inferior Calorific Value (kJ / mol) on a molar basis 

 Component Molar Mass Ratio (Ideal Relative Gas Density) 

 Component Ideal Gas Density (lbm/cu. ft. or kg/m^3) 

 Component GPM value (gallons / 1000 cu. ft.) 

 Component Compressibility (xi * bi) 

 Component Vapor Pressure (psia) 

 Component Relative Liquid Density 

 Component Absolute Liquid Density (lbm/gal.) 

 Component Molecular Weight 

 Component D2598 Vapor Pressure (psig) 



 

  Diablo EZReporter Software Getting Started    13 

 Component D2598 Relative Density 

Results Summary 

The calculation results are displayed in this section of the main screen.  Results 

displayed include, 

 Total un-normalized Amount 

 Total Normalized Amount 

NGA Edition: 

 Pressure Base used for the calculation 

 Gross Heating Value (BTU / real cu. ft.) or Superior Calorific Value (MJ 

/ m^3) on a volumetric basis 

 Gross Heating Value (BTU / lbm) or Superior Calorific Value (MJ / kg) 

on a mass basis 

 Gross Heating Value (BTU / gal.) 

 Superior Calorific Value (kJ / mol) on a molar basis 

 Net Heating Value (BTU / real cu. Ft.) or Inferior Calorific Value (MJ / 

m^3) on a volumetric basis 

 Net Heating Value (BTU / lbm) or or Inferior Calorific Value (MJ / kg) 

on a mass basis 

 Inferior Calorific Value (kJ / mol) on a molar basis 

 Real Relative Gas Density 

 Ideal and Real Gas Density (lbm / cu. ft. or kg / m^3) 

 Gas Compressibility (Z) Factor 

 Wobbe Index 

 Total Molecular Weight 

 Total GPM (theoretical hydrocarbon liquid content) 

 Total Vapor Pressure (psia and psig) 

 Total Relative Liquid Density 

 Total Absolute Liquid Density (lbm / gal and lbm / bbl) 

 Total Volume (cu. ft. / gal.) 

 API Gravity  

 D2598 Vapor Pressure (psig) 

 D2598 Relative Density 

Customizing the Report 

You can customize the report window by choosing which results to display, and 

what labels to use to describe each result. See “Report - Control” on page 29 for 

more information. 
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The Parameter Monitor Window 

This window shows the Parameter “Monitor” tab that displays the results from the 

last analysis for any monitored parameters.  High and low alarm limits can be set up 

for each monitored parameter.  See “The Parameter Monitor” on page 49 for more 

information on this capability. 

 
The “Parameter Monitor” tab on the main screen of the Diablo EZReporter 

The Parameter History Window 

This window shows the Parameter History tab that can be enabled to plot the 

historical values of any of the monitored parameters.  See “Parameter History” on 

page 49 for more information on this capability. 



 

  Diablo EZReporter Software Getting Started    15 

 
The “Parameter History” tab on the main screen of the Diablo EZReporter Software. 

The Results Database Window 

If the optional Results Database module is active, then the Results Database 

tab/window will be visible.  For more information about the Results Database 

module see, “The Results Database” on page 70. 
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The “Results Database” tab on the main screen of the Diablo EZReporter Software. 

Quick Start Instructions 

The following instructions describe the key steps that should be performed when 

using the software for the first time.  You will find more detailed instructions in later 

sections of this manual. 

Load and Edit the Configuration File 

The first time you run EZReporter the following window will be displayed allowing 

you to choose the default configuration file you would like to load: 
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Choose the default configuration that most closely matches your application or 

browse for a specific configuration file.  Once you have loaded the configuration file, 

you should configure the settings for your application.  To open the configuration 

editor, select the "Edit Configuration.." option of the "Tools" menu. 

Additional information about configuring the software can be found in "Configuring 

the Base Software" on page 24 and “Natural Gas Analysis” on page 54.  The default 

configuration files shipped with the software are listed in the following table. 

 

Important Important:  If you upgrade or re-install the EZReporter Software, all of the default 

configuration files listed in this table will be overwritten with the current versions.  

Consequently, if you use any of these default configuration files as the basis for a 

custom configuration, make sure to save your configuration file with a different file 

name. 

 

 

EZReporter Standard Configuration Files 

File Description 

Default Configuration Files 

STD Default.cfg The default configuration for standard/non-natural gas 

analysis applications.  It does not include any pre-

configured components.  You will need to add the 
components required for your analysis. 

NGA Default A default configuration for natural gas analysis 

applications (GPA 2172/2145 analysis with C1-C10 

components).  The Pressure Base is set to 14.73 in this 
file. 

C6+ Default.cfg An alternate configuration for natural gas analysis 

applications (GPA 2172/2145 analysis with C1-C6+ 

components)..  The calculation factors used for the 

hexanes plus component are based on a 60:30:10 

mixture of hexane, heptane, and octane.  The GPA 

2145-09 Standard was used to calculate the Hexanes+ 

calculation factors. 
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EZReporter Standard Configuration Files 

File Description 

ISO Default.cfg A default configuration for natural gas analysis 

applications (ISO 6976 analysis).  The physical 

property data are for a combustion temperature of 15 
Deg. C and a metering temperature of 15 Deg. C. 

ISO 6976 (0-0 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 

of 0 Deg. C and a metering temperature of 0 Deg. C. 

ISO 6976 (15-0 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 
of 15 Deg. C and a metering temperature of 0 Deg. C. 

ISO 6976 (25-0 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 

of 25 Deg. C and a metering temperature of 0 Deg. C. 

ISO 6976 (15-15 Deg C).cfg Identical to the ISO Default configuration with a 

combustion temperature of 15 Deg. C and a metering 

temperature of 15 Deg. C. 

ISO 6976 (205-20 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 
of 20 Deg. C and a metering temperature of 20 Deg. C. 

ISO 6976 (25-20 Deg C).cfg Similar to the ISO Default configuration except the 

physical property data are for a combustion temperature 
of 25 Deg. C and a metering temperature of 20 Deg. C. 

NGL Default (WtPct-

Combined).cfg 

A default configuration for Natural Gas Liquids (NGL) 

with “combined” extended fraction reporting.  With this 

calculation and reporting method the extended fraction 

results are reported separately and are also combined 

into the standard /total results through the specified 

combined component (usually Hexanes Plus).  This 

configuration includes the full component list from 

GPA TP-17 and GPA 2145-09. 

NGL Default (WtPct-Combined-

Corrected).cfg 

A default configuration for Natural Gas Liquids (NGL) 

with “combined” extended fraction reporting.  This 

configuration file is the same as the “Combined” 

configuration, but it is also set up to correct the raw 

component amounts in the extended fraction using a 

correction (“bridge”) factor calculated from the iso-

pentane and n-pentane amounts from the standard 

component range (usually from the TCD detector) and 

the extended component range (usually from the FID 

detector). 

NGL Default (WtPct-

Separate).cfg 

A default configuration for Natural Gas Liquids (NGL) 

with “separate” extended fraction reporting. With this 

calculation and reporting method, the extended fraction 

results are reported separately from the standard/total 

results.  This configuration includes the full component 

list from GPA TP-17 and GPA 2145-09. 

GPA 2145-03.cfg Contains the components and factors in the GPA 2145-

03 Standard.  The Pressure Base is set to 14.696 in this 
file. 

GPA 2145-09.cfg Contains the components and factors in the GPA 2145-

09 Standard.  The Pressure Base is set to 14.696 in this 
file. 
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EZReporter Standard Configuration Files 

File Description 

GPA 2177-03.cfg A configuration based on the GPA 2177-03 standard.  

The pressure base is set to 14.696 in this file. 

ASTM D3588-98 (2003).cfg Contains a sub-set of the components and factors in the 

ASTM D3588-98 (2003) standard.  The Pressure Base 
is set to 14.696 in this file. 

Refinery Gas.cfg A configuration containing common components found 

in refinery gas.  Physical properties are taken from GPA 

2145-09, ASTM D3588 (98), GPSA Engineering Data 

Book (2004) and other sources. 

Calculation Check Configuration Files 

GPA 2172-09 Calculation Check 

at 14.696 psia.cfg 

A configuration designed to check the GPA 2172-09 

NGA calculations made at a bas pressure of 14.696 

psia.  Simply load the corresponding data file (GPA 

2172-09 Example Data at 14.696 psia.btu) and switch 
to the “Parameters” table. 

GPA 2172-09 Calculation Check 

at 14.65 psia.cfg 

Same as above except it is designed to check the 

calculations at a bas pressure of 14.65 psia.  Make sure 

to load the correct data file (GPA 2172-09 Example 
Data at 14.65 psia.btu) 

GPA 2177-03 Calculation Check 

(VolPct).cfg 

A configuration designed to check the GPA 2177-03 

calculations made at a baes pressure of 14.696 psia.  

Simply load the corresponding data file (GPA 2177-03 
(VolPct).btu) and switch to the “Parameters” table. 

GPA 2186-02 Calculation Check 
(MolPct-Separate).cfg 

A configuration designed to check the GPA 2186-02 

NGL calculations using the Mole% component amounts 

and separate extended fraction report.  Simply load the 

corresponding data file (GPA 2186-02 Calculation 

Check (MolPct-Separate).btu) and switch to the 
“Parameters” table. 

GPA 2186-02 Calculation Check 

(WtPct-Combined).cfg 

A configuration designed to check the GPA 2186-02 

NGL calculations using the Weight% component 

amounts and combined extended fraction report.  

Simply load the corresponding data file (GPA 2186-02 

Calculation Check (WtPct-Combined).btu) and switch 
to the “Parameters” table. 

GPA 2186-02 Calculation Check 

(WtPct-Separate).cfg 

A configuration designed to check the GPA 2186-02 

NGL calculations using the Weight% component 

amounts and separate extended fraction report.  Simply 

load the corresponding data file (GPA 2186-02 

Calculation Check (WtPct-Separate).btu) and switch to 

the “Parameters” table. 

ISO 6976 Calculation Check.cfg A configuration designed to check the ISO 6976 NGA 

calculations.  Simply load the corresponding data file 

(ISO 6976 Calculation Check.btu) and switch to the 
“Parameters” table. 
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Important: Hint:  The order of the components in the component settings table is the order that 

they will be printed in the report.  You can easily rearrange the component order by 

first selecting a component's row in the table by left clicking on that row with the 

mouse.  Next, while the cursor is still pointing to that row, click and hold the right 

mouse button and drag the component to a new location in the table.  The row being 

moved will be highlighted in red.  Release the right mouse button when the 

component is located at the desired position in the table. 

Important:  Be careful rearranging the order of components if you are using 

Calculated Results or Export Templates that refer to component results.  In those 

instances components are identified by a component index, which is the order of the 

component in the component table.  If you rearrange the component table after you 

have set up a Calculated Result or Export Template, it is possible that the wrong 

component will be referenced. 

 

Specify Other NGA Calculation Parameters 

Make sure to set the Pressure Base to the correct value for your location or your 

contractual requirements (see “Natural Gas Analysis Settings” on page 57). 

Set the Report Preferences 

Modify the report titles as desired.  In addition, check "Print report for automatically 

processed results" if you would like a report to be printed automatically when the 

software generates a report upon receiving and processing results from the 

chromatography data system.  The report will be printed to the default printer. 

Set the Data File Preferences 

Specify the directory into which you would like to save EZReporter data files – use 

the "Browse" button to select or create the desired directory (see “Data Files” on 

page 32). 

Automatic file saving 

Check this box if you would like to have a data file created in the default data 

directory during automatic processing of data from the chromatography data system.  

The data files are named using a date + time format: 

 YYYYMMDD-HHMMSS.BTU  

Where YYYYMMDD is the current date and HHMMSS is the current time (e.g. 

20050208-153423.BTU). 

File Naming Options 

Check this box if you would like to have the sample name added to the Date+Time 

formatted file name during automatic processing.  If you enable this option, then you 

can also choose whether to add the sample name before (e.g. NGA Sample-

20050208-153423.BTU) or after (e.g. 20050208-153423- NGA Sample.BTU) the 

file name. 
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Set up your Chromatography Data System 

Follow the instructions in the EZReporter Quick Start guide to set up your 

chromatography data system to send results automatically to EZReporter for 

processing.  The Quick Start Guides can be found on the installation CD, or can be 

accessed via links in the Diablo EZReporter program group. 
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Running the Software 

The Main Menu 

The Diablo EZReporter is configured and controlled using the following menu 

options: 

File Menu 

New Data File 

Select this option to create a new data file and manually enter mole percent data.  See 

"Data Processing and Reporting" on page 51 for more information on this capability. 

Open Data File… 

Select this option to open an existing EZReporter data file saved on disk. 

Save Data File As… 

Select this option to save the current data and results to an EZReporter data file. 

Export Current Results 

Select this option to export the current results to a text file using the settings 

specified in the Export section of the current configuration. 

Save to Results Database 

Select this option to save the current results to the Results Database.  This option is 

only available if the Results Database license is in trial mode or has been activated. 

Load Configuration… 

Select this option to load a configuration file from disk.  This is a shortcut to opening 

the configuration editor and pressing the "Load" button. 

Sample-Specific Configurations… 

Select this option to enable the use of sample-specific configuration files when 

processing results automatically from a supported data system.  See “Sample-

Specific Configuration Processing” on page 52 for more information. 

Print 

This menu option allows you to print either the results that are currently displayed in 

the main screen (Print > Report), or the current settings being used by the software 

(Print > Current Settings). 
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The “Print > Report” menu option allows you to send the report to either the printer 

(Print > Report > Send to Printer) or save it to an Adobe PDF file (Print > Report > 

“Save as PDF). 

The “Print > Parameter History Plot…” menu option allows you to print the trend 

plot and summary statistics for the parameter currently selected in the Parameter 

History window. 

Print Setup… 

This option allows you to configure the printer. 

Exit 

This option immediately closes the software. 

Tools Menu 

Edit Configuration… 

This option displays the EZReporter Configuration Dialog box.  See "Configuring 

the Base Software" on page 24. 

Backup Current Configuration Files... 

This option backs up the current EZReporter configuration and log files into a single 

“Zip” archive file and optionally allows you to copy the file to a flash drive or other 

backup location.  The file is named, ‘ezrbackup-yyyymmdd-hhmmss.zip’, where 

‘yyyymmdd’ is the current year month and day, and ‘hhmmss’ is the current hour, 

minute, and second of the day.  The file is created in the EZReporter installation 

folder. 

Edit Current Data Set… 

This option allows you to re-edit manually entered data sets.  It is not available when 

an automatically processed data set from a chromatography data system is loaded.  

See "Data Processing and Reporting" on page 51. 

Show Export Template Variables… 

Displays a table of the “variables” that can be used in an export template file.  See 

the Appendix for more information about Export Templates. 

Help Menu 

Help Contents… 

Displays the contents page of the Diablo EZReporter help file. 

View Release Notes 

Opens the current release notes (readme.txt).  The release notes document the latest 

changes and enhancements to the software that may not have made it into this 

document. 

NGA Physical Property Update Procedure… 

Displays a special help file that describes the procedure you can use to update your 

existing EZReporter NGA configurations with new physical property constants 

License Status… 

Displays the current license status of the Diablo EZReporter software.  This menu 

option is not displayed in versions of the software that were purchased under a site 

license. 
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About Diablo EZReporter… 

Displays support and version information about the Diablo EZReporter. 

Configuring the Base Software Module 
The software is configured using the "Diablo EZReporter Configuration" window, 

which is displayed by selecting the "Edit Configuration.." option of the "Tools" 

menu.  Note that this dialog box is resizable. 

 
The Diablo EZReporter Configuration Window. 

Managing Configuration Files 

You can Load and Save configuration files using the "Load and "Save" buttons.  The 

“Save As” button allows you to save the current configuration to a new file.  

Configuration files are saved by default in the Diablo EZReporter installation 

directory.  You can also print a settings report using the "Print" button. 

 

Important Important:  If you upgrade or re-install the EZReporter Software, all of the default 

configuration files will be overwritten with the current versions.  Consequently, if 

you use any of the default configuration files as the basis for a custom configuration, 

make sure to save your configuration file with a different file name. 

 

Components 

The components "tab" of the configuration dialog is used to manage the list of 

components that will be included in the calculations and report.  See also 

“Component Settings for Natural Gas Analysis” on page 54 if you are using the 

Natural Gas Analysis option of the EZReporter software. 
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The "Components" tab of the Diablo EZReporter configuration window. 

Component Name 

The component names entered in the components table will be displayed in the 

component summary tables and reports. 

 

Important: Important:  If you are going to be processing data from a chromatography data 

system, then you must make sure that the names in the EZReporter component table 

match the names in the chromatography data system calibration/report exactly. 

 

Repeatability and Reproducibility Limits 

Note: These fields are only visible if the Results Database Module is active. 

These two fields contain relative-percent values for each component and are used in 

the Results Database results comparison window to compare the normalized Mole% 

results from two samples.  Although they are intended to be used with the GPA 2261 

repeatability (r) and reproducibility (R) limits shown in the table below, you can use 

whatever values are appropriate for your needs.  See “Comparing Results” on page 

79 for more information. 
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Component Repeatability 
(Relative %) 

Reproducibility 
(Relative %) 

Nitrogen 2 7 

Carbon Dioxide 3 12 

Methane 0.2 0.7 

Ethane 1 2 

Propane 1 2 

Isobutane 2 4 

n-Butane 2 4 

Isopentane 3 6 

n-Pentane 3 6 

Hexanes Plus 10 30 

GPA 2261-00 Repeatability and Reproducibility Limits 

Repeatability limits are typically used to compare results from the same sample, 

instrument, experimental conditions, and analyst (for example when evaluating a 

calibration or validation standard).  Repeatability limits should not be used to 

compare flowing samples whose composition may change with time. 

Reproducibility limits are typically used to compare results from the same sample 

and method, but different instruments and analysts. 

Manual Amount/Mole% Entry 

Check this box if you are using the software to generate reports automatically from a 

chromatography data system, and you need to be able to enter the specified 

component mole percent based on the results of a separate analysis.   

When results from the data system are processed, a dialog box will be displayed, 

allowing you to enter the component's un-normalized amount or mole%, which will 

then be included in subsequent calculations. 

Adding new components 

Press the "Add" button to add a new row to the component table manually.  The row 

will be added below the currently selected row. Enter the component name and 

calculation factors for the new component. 

Deleting existing components 

To delete a component from the component list, select the row containing the desired 

component and press the "Delete" button". 

Changing the component order 

The order of the components in the component settings table is the order that they 

will be printed in the report.  You can easily rearrange the component order by first 

selecting a component's row in the table by left clicking on that row with the mouse.  

Next, while the cursor is still pointing to that row, click and hold the right mouse 

button and drag the component to a new location in the table.  The row being moved 

will be highlighted in red.  Release the right mouse button when the component is 
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located at the desired position in the table. 

 

Important: Important:  Be careful rearranging the order of components if you are using 

Calculated Results or Export Templates that refer to component results.  In those 

instances components are identified by a component index, which is the order of the 

component in the component table.  If you rearrange the component table after you 

have set up a Calculated Result or Export Template, it is possible that the wrong 

component will be referenced. 

 

Clearing the table 

Press the “Clear” button to delete all components from the component table. 

Undoing changes to the component list 

Press the “Undo” button to return the component list to the last saved configuration. 

Component Table Context Menu 

The following context menu will pop up when you right click with the cursor 

anywhere in the component table: 

Add new component below:  Clicking this option will result in a new blank line 

being added to the component table directly below the currently selected line. 

Clone selected component below:  Clicking this option will result in a new line 

being added to the component table directly below the currently selected line.  All of 

the component physical property data and other settings will be copied from the 

selected component.  The cloned component name will have a “*” appended to it as 

a reminder that you need to rename it (duplicate component names are not allowed). 

Delete selected component:  Clicking this option will delete the currently selected 

component. 

Calculation Settings 

The “Calculation Settings” tab of the configuration window allows you to modify 

miscellaneous settings associated with calculations. 
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The "Calculation Settings" tab of the Diablo EZReporter configuration window 

Component Amount Precision 

Use this option to set the number of decimal places to round the component amount 

or mole percent values prior to their being used in calculations.  Component and 

related total amounts will also be displayed in the report using this number of 

decimal places. 

 

Important: Important:  The normalized mole% values will be rounded to the number of 

decimal places specified in this setting before they are used in any calculations.  In 

addition, if rounding causes the total normalized mole% not to sum to 100%, then a 

correction is made to the normalized mole% of the most concentrated component in 

the sample (usually methane in NGA applications) to force the total to 100%. 

 

Internal Standard Amount Mapping 

This is an advanced option that allows you to map the Internal Standard Amount 

from an analysis to the raw mole% of one of the components.  This means that you 

can enter a result from another analyzer (e.g. H2S from a Draeger tube) into the 

chromatography data system sequence, and have it automatically applied to the 

specified component without requiring reprocessing or prompting. 

 

Important: Note 1:  Some data systems will switch the ISTD Amount from 0 or blank to 1 in the 

sequence table.  Consequently, you may need to enter a very small non-zero number 

for 0 (for example 0.000001). 

Note 2:  There may be additional method settings required to enable this capability.  

Please see the EZReporter Quick Start Guide for your data system. 
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Report - Control 

The "Report" tab of the configuration dialog allows you to customize the printed 

report. 

 

The “Report Control” section of the "Report" Tab of the Diablo EZReporter Configuration 
Screen 

Report Control 

Check the “Print report for automatically processed results” box if you would 

like a report to be sent to the default printer when processing data automatically from 

a chromatography data system. 

By default, all components in the component table will be included in the report.  

Check “Report only components with amount > 0” if you would like components 

with a raw amount of 0 to be excluded from the component results in the report. 

Monitored parameters 

Check the “Print parameter report” option if you would like to have a monitored 

parameter report printed along with the standard results report.  If you also check the 

“Report only parameters with failed alarms” option, then only those parameters 

whose value has exceeded an enabled alarm limit will be included in the parameter 

report. 

Report Margins 

You can set the margins of the printed report in inches in order to make space for 

letterhead or logo, or to increase or decrease the number of lines printed on each 

page. 
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PDF File Control 

These settings allow an Adobe Acrobat, “PDF” version of the report to be saved to a 

specified folder when processing results automatically.  To enable this option check, 

“Save PDF file for automatically processed results”. 

Save PDF File to Folder:  Click the “Open” button to select the directory to 

which the “PDF” files will be saved. 

PDF File Name:  These options are used to specify the PDF file name.  You can 

choose to name the PDF file based on the name of the EZReporter data file (see the 

“Data Files” tab), or you can enter a “fixed” file name.  If you choose the first 

option, the PDF file will have the same base file name as the EZReporter data file.  

You can also have the export file named based on the sample name from the 

chromatography data system. 

Append Additional Text 

This option allows you to append additional custom text to the bottom of the report – 

below the total/summary results table.  You can either edit the file “additional.txt” by 

clicking the Notepad icon, or browse and select a different file containing the desired 

text.  You can also choose whether the text is left, center, or right justified on the 

report page. 

Note:  This additional text is only included in the printed report.  It is not displayed 

on screen. 

Report – Titles 

You can modify all of the titles, captions, and labels displayed on the report in the 

“Report Titles” tab. 

 
The “Titles” section of the "Report" Tab of the Diablo EZReporter Configuration Screen 
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Report - Customize 

 
The “Customize” section of the "Report" Tab of the Diablo EZReporter Configuration Screen 

The result table shown in the “Customize” tab of the Report configuration screen 

allows you to customize the viewed/printed report.  You can change the text of the 

labels that identify a result on the report, set the formatting of numeric results, and 

add or remove results from the report by checking or un-checking the checkbox in 

the “Report” column. 

Note that the “|” character is converted into a line break when the labels are rendered 

onto the report.  This is particularly useful for component results when you want to 

minimize the width of the component result column. 

Format 

You can set the numeric formatting for a result by entering a format string in the 

corresponding field.  Examples of common formatting strings are shown in the table 

below. 

Important:  The format of component and related total amount results is determined 

by the “Component Amount Precision” setting (see “Component Amount Precision” 

on page 28).  You are not able to customize the format of those results. 

 

Format String Result 

0 Will display all digits to the left of the decimal point and no digits to 

the right: 

The value 10000.2324 will be displayed as 10000 

The value 0.2324 will be displayed as 0 

0.00 Will display all digits to the left of the decimal point and two digits 

to the right of the decimal place: 

The value 232.4012 will be displayed as 232.40 

The value 232 will be displayed as 232.00 

0.0### Will display all digits to the left of the decimal place, and from 1 to 4 
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digits to the right of the decimal place: 

The value 232.4012 will be displayed as 232.4012 

The value 232.4 will be displayed as 232.4 

The value 232 will be displayed as 232.0 

Common numeric formatting strings. 

Context Menu 

If you right click anywhere on the report/result table, the following context menu 

options will pop up: 

Select all results:  Check all of the results currently displayed in the table. 

Select no results:  Uncheck all of the results currently displayed in the table. 

Select default results:  Check only the results that are included in the default 

configuration. 

Reset report labels to default values:  Resets all of the report labels to their original, 

default value. 

Data Files 

The settings in the "Data Files" tab of the configuration dialog allow you to 

customize how data files are handled. 

 

The "Data Files" Tab of the Diablo EZReporter Configuration Screen 

Default Data Directory 

Specify the directory into which you would like to save data files – use the "Browse" 

button to select or create the desired directory. 
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Automatic File Saving 

Check this box if you would like to have a data file created in the default data 

directory during automatic processing of data from a chromatography data system. 

There are two options available for naming the data files 

Use data system data file name 

If you choose this option, the data file will be named based on the source data file 

name generated by the chromatography data system.  The file will be named with the 

same base filename, but with the “.BTU” file extension instead of the “.DAT” file 

extension. 

Auto-Generate Data File Name 

  The data files are named using a Date + Time format: 

 YYYYMMDD-HHMMSS.BTU  

Where YYYYMMDD is the current date and HHMMSS is the current time (e.g. 

20050208-153423.BTU). 

Auto-Generated Data File Naming Options 

Check this box if you would like to have the sample name added to the Date+Time 

formatted file name during automatic processing (e.g. NGA Sample-20050208-

153423.BTU). 

Sample Name Options 

This option allows you to set whether the sample name is added before or after the 

file name.  Select “Before” (e.g. NGA Sample-20050208-153423.BTU) if you want 

the data files to sort alphabetically by sample name when you view the data file 

directory in Windows Explorer.  Select “After” (e.g. 20050208-153423-NGA 

Sample.BTU) if you want the data files to sort by the Date/Time. 

File Format 

This option sets whether the data files are saved using a Comma or a Tab as the 

delimiter character between fields in the file. 

Sample Info 

These options allow you to enable and configure custom sample information fields 

that can be used to report additional conditions like well number, pressure, 

temperature, etc.  They are simply a way for the user to enter additional custom 

information during an analysis, and have that information printed on reports and 

saved in the data and export files. 
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The "Sample Info" Tab of the Diablo EZReporter Configuration Screen 

Check the “Enable custom sample information fields” checkbox to enable the custom 

sample information fields.  Press the “Add” button to add a new sample information 

field, or the “Delete” button to delete the field that is currently selected.  The 

captions are displayed on the printed report, and when you are prompted to enter the 

associated custom sample information.  You can also specify whether the field is 

numeric. 

Default Value 

A default value can be specified for each of the custom sample information fields.  

The default value will be displayed automatically when the Sample Information 

dialog box is displayed.  However, if the “Recall” option is set and a previous value 

exists for the field, then the previous value will be displayed instead of the default 

value. 

Numeric Sample Information Fields 

If a sample information field is numeric, special numeric formatting and scaling can 

be applied to the value in the export file.  See “Data Export” on page 35 for more 

information. 

Recall Last Value 

Check the “Recall” check box if you would like the last value entered into this field 

to be recalled when the form is displayed. 

Report 

If the “Report” checkbox is checked, then the field will be displayed in the “Sample 

Information” section of the report.  If it is unchecked, then the field will not be added 

to the report.  
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Changing the order of Sample Information Fields 

The order of the fields in the sample information table is the order that they will be 

printed in the report and displayed in the sample information prompt.  You can easily 

rearrange the field order by first selecting a field's row in the table by left clicking on 

that row with the mouse.  Next, while the cursor is still pointing to that row, click 

and hold the right mouse button and drag the field to a new location in the table.  

The row being moved will be highlighted in red.  Release the right mouse button 

when the field is located at the desired position in the table. 

 

Important: Important:  Be careful rearranging the order of the Sample Information fields if you 

are using Export Templates that refer to Sample Information fields.  In those 

instances Sample Information fields are identified by their index, which is their order 

of in the sample information table.  If you rearrange the sample information table 

after you have set up an Export Template, it is possible that the wrong Sample 

Information field will be referenced. 

 

Entering custom sample information: 

If you have enabled custom sample information fields, and if at least one of the fields 

contains a caption, then “Manual Data Entry” dialog box will be displayed when 

automatically processing results from a chromatography data system.  This dialog 

box will display the caption(s) specified in the Sample Info configuration, and allow 

the associated custom sample information to be entered by the user.  Alternatively, 

you can manually enter the sample information using the “Tools > Edit Current Data 

Set…” menu option. 

 
The "Diablo EZReporter Manual Data Entry "window showing the custom sample information 
fields. 

Data Export 

The EZReporter software includes a flexible data export feature that allows you to 

create custom data export files in almost any format you might need.  An export 

template file defines the format of the export file. 
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Export Configuration Panel 

Export Options 

Check “Create export file for automatically processed results” if you want the results 

from a chromatography data system to be exported automatically when the data is 

processed by the EZReporter software. 

Check “Append results if export file already exists” if you want the exported results 

to be appended to any results that already exist in the specified export file.  If this 

option is unchecked, then existing results will be overwritten. 

Export Template File 

Click the “Open” button to specify the template file that will be used to create the 

export file.  Click the “Notepad” button to open the selected export template file in 

Windows Notepad for editing.  See “Export Template Format” in the Appendix on 

page 86 for information on creating and editing Export Template files.  Note that 

several example template files are included with the software in the application 

“Settings” folder. 

Export Directory 

Click the “Open” button to select the directory to which export files will be saved. 

Export File 

These options are used to specify the export file name.  You can choose to name the 

export file based on the name of the EZReporter data file (see the “Data Files” tab), 

or you can enter a “fixed” file name.  If you choose the first option, the export file 

will have the same base file name as the data file. 
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You can also have the export file named based on the sample name.  This allows 

results from replicate runs of the same sample to be added appended to the same 

export file even though the data file names are different. 

Export File Extension:  Enter the file extension to use for the export file into this 

text box field.  The default extension if this field is left blank is “txt”. 

Note:  if you enter a fixed export file name that already includes a file extension, it 

will take precedence over the entry in the Export File Extension field. 

Show Template Variables 

If you click this button, a table of supported template variables with descriptions will 

be displayed.  You can print this list by pressing the “Print” button. 

 

Hint: Hint:  If you double-click on a particular variable, it will be copied to the Windows 

clipboard so that you can paste it into a template file. 

 

 

 
EZReporter Template Variable Table 



 

38    Running the Software   Diablo EZReporter Software 

Calculated Results 

Calculated results are based on custom formulas you enter using the “Formula 

Builder”.  The Formula Builder allows you to select from a list of available result 

variables and supported arithmetic operators to build a custom formula that will be 

evaluated to a numeric value when processing results.  The Calculated Result is then 

displayed in the Results Summary part of the report along with a descriptive caption 

that you also specify. 

Calculated Results can also be used as Monitored Parameters for alarming and trend 

plotting and both the caption and value can be specified in an Export Template and 

exported to a text file. 

 
The EZReporter Calculated Results configuration table 

Adding Calculated Results to the Configuration and Report 

To add a Calculated Result to the configuration and report: 

1. Click the “Add” button. 

2. In the new line that is added to the Calculated Results table, enter a caption 

that describes the result.  This caption will be displayed along with the 

calculated value in the “Results Summary” section of the report. 

3. Click the […] button that is visible when you click in the “Formula” cell to 

display the Calculated Result Formula Builder and create the custom 

formula. 

4. Check the “Report” checkbox if you want this Calculated Result displayed 

in the report. 

5. Enter the desired numeric format string for this result.  See “Format” on 

page 31 for information on specifying the numeric format. 
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Creating a Custom Formula using the Formula Builder 

You create a custom formula for a Calculated Result using the Formula Builder tool 

that is displayed by clicking the […] button when the cursor is in the Formula cell of 

the Calculated Results table. 

Formulas consist of Result Variables and arithmetic Operators (+,-,*, etc.).  Simply 

double click the desired Result Variable or Operator from the respective list and it 

will be inserted at the current cursor location in the “Current Formula” box.  See 

“Calculated Result Formula Builder Operators” on page 107 in the appendix for a 

description of supported operators. 

 
The EZReporter Custom Calculation Formula Builder 

If the Result Variable you have selected is a Component Result, you will also be 

prompted to select the desired component. 

 

 

IMPORTANT: Important:  If you have included any Component Variables in the custom formula, 

you should not change the order of components in the main Component Table.  

Component variables are linked to the specific component by the component 

number, which is based on the order they are displayed in the component table.  If 

you change the component order, it is possible that the formula will be linked to a 

different component than expected. 
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Once you have created the custom formula you can check that the syntax is valid by 

clicking the “Check Syntax” button.  If the formula syntax is invalid, an error 

message will be displayed: 

 

If the formula syntax is valid, the result of the calculation will be displayed.   Note 

that the result of the calculation will be 0 unless there is a current report with actual 

results displayed in the main EZReporter Sample Result window in which case it 

will use the actual result values in the calculation. 

 

Parameter Options 

The “Parameters” tab allows you to configure a list of component or calculated 

results that will be displayed in the “Parameter Monitor” window of the main 

software screen.  You can set both high and low alarm limits for these monitored 

parameters – if the parameter value exceeds either of these limits, the result will be 

displayed with a red background in the parameter table to alert you. 

 

 
The Parameter Monitoring configuration panel 

Options:  Clicking the “Option” button displays the Monitoring Options dialog 

box.  See “Setting Monitored Parameter Options” on page 41. 



 

  Diablo EZReporter Software Running the Software    41 

Add:  Clicking the “Add” button allows you to configure and add a new parameter 

to the monitored parameter table.  See “Adding or Editing Monitored Parameters” on 

page 43. 

Edit:  Clicking the “Edit” button allows you to edit the options for the parameter that 

is currently selected the parameter table.  You can also double-click the desired row 

in the table to edit a parameter’s options.  See “Adding or Editing Monitored 

Parameters” on page 43. 

Delete:  Clicking the “Delete” button will remove the selected parameter from the 

parameter table. 

Clear:  Clicking the “Clear” button will clear the parameter table. 

Undo:  Clicking the “Undo” button will restore the parameter table to the last saved 

configuration. 

Help:  Clicking the “Help” button displays context-sensitive help for this topic. 

Changing the Display Order of Parameters 

To rearrange the order of the parameters in the parameter table, first select the row of 

the parameter you want to move by left clicking on that row with the mouse.  Next, 

while the cursor is still pointing to that row, click and hold the right mouse button 

and drag the selected row to the desired new location in the table.  Release the right 

mouse button when the field is located at the desired position in the table. 

Cloning Parameters 

Right clicking on a parameter in the table displays a context menu that allows you to 

clone the properties of the selected parameter to a new parameter.  This allows you 

to create a new parameter quickly using an existing parameter as a template. 

Auto-add All Components 

Right clicking on a component parameter table displays a context menu that allows 

you to add the remaining components in the configuration to the parameter table 

using the selected component parameter as the template. 

Setting Monitored Parameter Options 

Click the “Options” button to set additional options for the Parameter Monitoring. 

Monitor Options Tab 
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Parameter Monitoring Options Dialog – Monitor Options Tab. 

Parameter Table Options 

Check the “Display alarm limits in parameter table” option if you would like to 

include the actual upper and lower alarm limits in the parameter table along with the 

parameter name and value.  This can be especially useful when using relative alarm 

limits so that you can see the actual calculated limits for each parameter. 

Parameter Display Font 

In the “Parameter Display Font” section, use the “Size” list box and “Bold” and/or 

“Italic” check boxes to set the desired font for the Monitor Table.  A preview of the 

font is displayed for you. 

 

History Plots Tab 

 
Parameter Monitoring Options Dialog – History Plots Tab 

Enable Parameter History Plots:  Check this box to enable history plots for the 

monitored parameters.  Note that this option will be set automatically if history plots 

are enabled for any of the individual parameters. 

X-Axis Data Source:  You can choose to plot the parameter values against a 

sequential data point/run number, the current time when the report/results are 

generated, or the injection date/time of the chromatographic run. 
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X-Axis Scroll Window: The X-Axis will automatically zoom to this time (in 

minutes) or data point window.  When new results are received, older data points 

outside this window will no longer be visible.  However, the entire history plot can 

be displayed at any time by clicking the “Zoom Full” button, or double-clicking on 

the plot window. 

Y-Axis Scaling:  You can choose to have the y-axis scale adjusted automatically so 

that the range includes only the data points that are visible in the current 

plot/window.  Alternatively, you can choose to have the y-axis scale adjusted so that 

it represents the full range of parameter values, including those outside the current 

plot/window. 

 

Important: Important Note:  If you have enabled either high or low alarm limits in the 

parameter configuration, then those limits will be displayed as red, dotted lines on 

the history plot.  Those alarm limits are included when determining the Y-axis range. 

 

Parameter Series Display Mode:  You can display each parameter history plot 

series either individually or with all series overlaid on the same axes. 

Adding or Editing Monitored Parameters 

Click the “Add” button to add a new monitored parameter or the “Edit” button to 

edit the monitored parameter currently selected in the parameter table (you can also 

double click the line in the table that you want to edit).  You can also clear the 

current table by pressing the “Clear” button, or undo any changes you have made to 

the table by pressing the “Undo” button. 

 
The Edit Monitored Parameter dialog 

Parameter:  Select the parameter that you want to monitor from this list box.  If 

you select a parameter that is derived from a component result (component amount, 
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for example), then you will also need to specify the corresponding component from 

the component list box. 

Note that if the NGA Module is active, the parameter list will include a number of 

different NGA-related result parameters.  If the NGA module is not active, only 

chromatographic parameters like retention time, peak area, and amount will be listed. 

Component:  If you select a parameter that is derived from a component result 

(component amount, for example), then you will also need to specify the 

corresponding component from the component list box. 

Format:  You can set the numeric formatting for the displayed parameter value by 

entering a format string in this text box.  Examples of common formatting strings are 

shown in the table below. 

 

Format String Result 

0 Will display all digits to the left of the decimal point and no digits to 

the right: 

The value 10000.2324 will be displayed as 10000 

The value 0.2324 will be displayed as 0 

0.00 Will display all digits to the left of the decimal point and two digits 

to the right of the decimal place: 

The value 232.4012 will be displayed as 232.40 

The value 232 will be displayed as 232.00 

0.0### Will display all digits to the left of the decimal place, and from 1 to 4 

digits to the right of the decimal place: 

The value 232.4012 will be displayed as 232.4012 

The value 232.4 will be displayed as 232.4 

The value 232 will be displayed as 232.0 

Common numeric formatting strings. 

Default:  If you click the “Default” button, the default formatting string for this type 

of parameter will be copied into the format text box for you. 

Display Name:  The text entered into the “Display Name” text box will be 

displayed for this parameter in the Monitor Table.  You can click the [<] button to 

copy text from the parameter and component (if appropriate) list boxes into the text 

box. 

Enable History Plot for this parameter:  If you check this box, then the value 

of this monitored parameter will be plotted in the Parameter History display. 

Parameter Alarms 

You can enable both high and/or low parameter alarms by checking either one or 

both of these check boxes and selecting the desired alarm type/limit. 
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The “Alarms” tab of the Edit Monitored Parameter window showing both High and Low 

Alarms enabled. 

If an alarm is enabled and the parameter value exceeds the specified limit, the result 

will be displayed with a red background in the Monitor Table to alert you.  

Conversely, if the alarm is enabled and the parameter value does not exceed the 

limit, the result is displayed with a green background. 
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The EZReporter software supports several types of Alarms, including fixed alarm 

limits, and relative alarm limits.  Use the “Alarm type” list box to select the type of 

alarm limits to use for the parameter. 

Fixed Alarm Limits 

With the “Fixed alarm limits” alarm type you simply enter the upper and lower 

values for the alarm limits. 

 
The “Alarms” tab of the Edit Monitored Parameter window showing the settings for fixed 
upper and lower alarm limits. 

Relative Alarm Limits 

With “Relative alarm limits” you must enter an alarm value and the limits are 

calculated relative to that value.  You can specify whether you want the limits 

calculated as a percent relative to the Value (Value +/- %Limit of the Value) or use 

absolute limits (Value +/- Limit). 
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The “Alarms” tab of the Edit Monitored Parameter window showing the settings for relative 
alarm limits. 

Text Alarms 

Text alarms are available when the chosen parameter is a non-numeric, text result 

like “Sample Name”.  If you enable the Text Alarm, the alarm will be triggered when 

the parameter text matches the alarm condition defined by the “Alarm Text” and the 

“Alarm when” setting.  The comparison is not case sensitive. 

 
The “Text Alarms” tab of the Edit Monitored Parameter window showing the settings for a 
Text Alarm. 
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Sample History Alarm Limits 

Sample History alarm limits are available as an option if the Results Database 

module is activated.  With this type of alarm limit, the average and standard 

deviation are calculated from the historical results retrieved from the results database 

using the Sample Name along with additional filters.  The following kinds of limits 

can be specified: 

 %Relative (Avg +/- %Limit * Average):  Here, the alarm limits are 

calculated as a percentage relative to the historical average for this sample. 

 Absolute (Avg +/- Limit):  Here the alarm limits are calculated as an 

absolute value around the historical average for this sample. 

 Standard Deviation (Avg +/- Limit * Standard Deviation):  Here the alarm 

limits are calculated using the historical average and standard deviation for 

this sample.  You can specify the multiplier for the Standard Deviation in 

the Limit field. 

The “Sample/Results Filters” section provides a way to further refine the sample 

results used to calculate the historical average and standard deviation.  You can 

choose to filter the results using the same settings that are used when the results are 

displayed in the sample results summary table, or enter custom filters for this 

particular alarm. 

 
The “Alarms” tab of the Edit Monitored Parameter window showing the settings for relative 
alarm limits. 



 

  Diablo EZReporter Software Running the Software    49 

Using Monitored Parameters and History Plots 

The Parameter Monitor 

Monitored parameters are displayed in a table on the “Parameter Monitor” tab of the 

main software screen.  The parameter table displays the results for monitored 

parameters from the last analysis or last data file loaded. 

If either the high or low alarm is enabled for any of the monitored parameters, then 

the background color of the parameter value will be either red or green depending on 

whether the actual value exceeds the enabled alarm limit. 

 

 
The EZReporter Parameter Monitor Window 

Parameter History 

Historical values of monitored parameters can be plotted in the Parameter History 

window. 

In order to display the parameter history window, you must enable history plots for 

each individual parameter whose results you want to plot.  See “Parameter Options” 

on page 40” for more information. 

The individual parameter history plots and summary statistics are displayed by 

clicking on the desired parameter display name in the parameter list.  If either high or 

low alarm limits have been enabled for a parameter, then the parameter name will be 

displayed with either a red or green background to indicate whether the current 
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parameter value has exceeded an alarm limit (red background) or not (green 

background).  In addition, the alarm limit is displayed a s red, dotted line on the 

history plot. 

 
The “Parameter History” tab on the main screen of the Diablo EZReporter 

Reset History:  Click the “Reset History” button to clear and reset the history plot 

and summary statistics for all plotted parameters. 

Zoom Full:  Click the “Zoom Full” button to expand/contract the X and Y axes of 

the history plot to display the entire plot.  Double-clicking in the history plot window 

performs the same function. 

Options:  Click the “Options” button to change the X-axis scroll window or Y-axis 

scaling mode: 
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Copy:  Click the “Copy” button to copy the currently displayed trend plot to the 

Windows clipboard. 

Print:  Click the “Print button to print the currently displayed history plot and 

summary statistics. 

Export:  Click the “Export” button to export the history results for all components 

to a comma-delimited text file. 

Help:  Click the “Help” button to display context-sensitive help for this topic. 

Data Processing and Reporting 

Manual Data Processing and Reporting 

It is possible to enter component mole% values manually and calculate results based 

on those values.  Select "New Data Set…" from the "file" menu.  Any existing 

results will be cleared from the main screen, and you will be presented with the 

Manual Data Entry dialog.  Enter the mole% values into the component table, and 

optionally a sample name, user name, and comments, and then press the "Process" 

button to perform the calculations. 
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Manual Data Entry Dialog Box 

Important: Important:  Make sure to save these results to an EZReporter data file (select "Save 

Data Set As…" from the "File" menu) if you want to be able to recall the data at a 

later time.  You can print a report by selecting "Print > Report" from the "File" 

menu. 

 

You can re-edit the data you entered manually by selecting "Edit Current Data 

Set…" from the "Tools" menu.  Note however, that for purposes of data integrity, 

this option is disabled for data sets from a chromatography data system that were 

processed automatically. 

Automatic Data Processing and Reporting 

Refer to the EZReporter Quick Start Guide for your chromatography data system for 

instructions on how to configure the data system to send results automatically to 

EZReporter for data processing and reporting. 

Sample-Specific Configuration Processing 

Sample-Specific Configuration Processing allows you to use different EZReporter 

configuration files based on the sample name when automatically processing results 

from a supported data system. 

To configure this feature, select the “File > Sample-Specific Configurations…” 

menu option. 
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Check or uncheck the “Enable Sample-Specific Processing” checkbox to enable or 

disable this feature.  If enabled during automatic processing of results from one of 

the supported data systems, the sample name from the data system is compared to the 

sample names in the table.  If a match is found, the corresponding configuration file 

is loaded prior to processing the sample results. 

Simply click the “Add” button to add a sample name and the corresponding 

configuration file that should be used for that type of sample.  You can include ‘*’ 

and ‘?’ wildcard characters in the sample name.  The ‘*’ character will match any 

character or characters in that position, while the ‘?’ matches a single character in 

that position. 

Note:  If a sample name matches both a fixed sample name (“Air Sample”) and a 

wildcard sample name (“Air*”), then the configuration file specified for the fixed 

sample name will be used.  If a sample name matches more than one wildcard entry, 

then the configuration file for the first entry alphabetically will be used. 

The mandatory “Default” configuration file is selected whenever a sample name 

doesn’t match any of the sample names in the table. 
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Natural Gas Analysis 

Configuring Natural Gas Analysis 

If you have activated the Natural Gas Analysis (NGA) option, you will need to 

configure the EZReporter software to generate the appropriate results for your 

situation. 

Component Settings for Natural Gas Analysis 

The components "tab" of the configuration dialog is used to manage the list of 

components that will be included in the calculations and report.  You can either edit 

the component properties directly, or you can click the “Std Components” button to 

select from a list of standard components and their physical properties.  See 

“Standard Component Physical Properties” on page 55 for more information 

 

Component Name 

The component names entered in the components table will be displayed in the 

component summary tables and reports. 
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Important: Important:  If you are going to be processing data from a chromatography data 

system, then you must make sure that the names in the component table match the 

names in the data system calibration table and report. 

 

Component physical properties 

Each default configuration file is based on a set of standard physical properties – 

usually based on GPA Standard 2145-03 or 2145-09 or ISO 6976 (1995).  You 

should review the component physical properties to make sure that they are correct 

for your situation. 

 

Important: Important:  These physical properties should be ideal gas properties at 60 Degrees F 

and 14.696 psia.  Entering physical properties determined at different temperatures 

or pressures will result in incorrect calculations. 

 

Standard Component Physical Properties 

Press the “Std. Components” button on the Components tab of the configuration 

editor to display a table of standard components and their physical properties. 

You can use the “Data Source” list box to display tables of standard physical 

properties from different data sources.  These data sources currently include the GPA 

2145-03 and 2145-09 Standards, the extended component list from the GPSA 

Engineering Data Book (12 Edition, 2004), the GPA TP-17 physical property tables, 

the ASTM D3588-98 (2003) and D2598-02 Standards, and the ISO 6976 Standard. 

 

You can also double-click on any cell in the table to transfer that particular value to 

the Windows Clipboard.  You can then paste that value into the component list. 
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Important: Important:  Physical properties for “Hexanes Plus” are calculated assuming a 

60:30:10 mixture of hexane, heptane, and octane. 

 

After checking the components you want to add/update, click the “Transfer” button 

to transfer them to the component list.  If a component with the same name already 

exists in the component list, its physical properties will be updated to those from the 

table.  If there is no matching component with the same name, then the “Unknown 

Component” dialog box will be displayed. 

Context Menu 

If you right click the cursor anywhere in the standard components table, the 

following context menu options will pop up: 

Select all components:  Check all of the components in the displayed standard 

component table. 

Select no components:  Uncheck all of the components in the displayed standard 

component table. 

Select matching components:  Check the components in the displayed standard 

component table whose name matches a component name in the component table of 

the currently configuration. 

Physical Property Transfer Options 

When you click the “Transfer” button, the following dialog box will be displayed 

allowing you to select which physical property data to transfer from the selected data 

source to the current configuration.  When you have chosen the desired properties, 

click the “Transfer” button to begin the transfer. 

 

Unknown Component Dialog Box 

If you select a standard component whose name doesn’t match one of the existing 

entries in your component list, the “Unknown Component” dialog box is displayed.  

This dialog box gives you the option to either append the selected standard 

component to the end of your component list, or to copy the physical properties for 
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the standard component to an existing component in your component list.  This 

allows you to update the physical properties for components that you may have 

named differently than the standard names (“CO2” vs. “Carbon Dioxide”, for 

example) 

 
The “Unknown Components” dialog box. 

To update the physical properties for an existing component, select “Copy the 

properties to an EXISTING component”, and then choose the correct component 

name from the list box.  Click “OK” to transfer the standard physical properties to 

the selected component in your configuration. 

You will have to repeat this process for each unknown component in your 

configuration file. 

Natural Gas Analysis Settings 

The "Natural Gas Analysis" tab of the configuration dialog allows you to specify 

additional calculation factors.  
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The "Natural Gas Analysis" Tab of the Diablo EZReporter Configuration Screen 

NGA License Status 

This window displays the current license status of the Natural Gas Analysis (NGA) 

optional feature.  If the EZReporter software is in trial mode or if the NGA feature is 

not activated, then the “Activate License” button is enabled.  Click this button to 

display the license activation window. 

Disable Natural Gas Analysis Calculations and 
Reporting 

If you want to use the software for general reporting and exporting, you can disable 

NGA calculations and reporting by checking this check box under Report Control. 

 

Important: Important:  The resulting report/results will not include any of the calculated NGA 

results – only the component retention time, peak area, raw (un-normalized) amount, 

total raw (un-normalized) amount, normalized%, and total normalized%.  All other 

features of the software including exporting and monitoring, still work as normal. 

 

NGA Physical Property Base Data Source 

The physical property data source used as the basis for the physical properties in the 

configuration is displayed.  The data source is set correctly in all of the default 

configuration files.  However if you are loading an older configuration file, you will 

need to manually identify the correct data source by clicking the “Edit” button.  The 

following window will be displayed for you to select the data source: 
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Important: Important:  Your selection is not validated in any way.  If you want to be sure that 

the physical properties in your configuration are from the selected data source, then 

click the “Transfer” check boxes and update the physical properties of all your 

components with values from the selected data source. 

 

Base Temperature 

The Base Temperature is determined by the data source you are using and can not be 

changed.  It is displayed for informational purposes only. 

Base Pressure 

Enter the pressure base in psia to use for the calculations into this text box.  The 

calculated results will be corrected to reflect their values at the specified Pressure 

Base. 

Note:  All of the default configuration files that ship with the EZReporter software 

use a Pressure Base of either 14.696 or 14.73 psia (14.696 psia for the configuration 

files that derive from a GPA or ASTM standard, and 14.73 psia for “default.cfg” and 

“hexanes plus.cfg”).  It is the customer’s responsibility to determine the correct 

Pressure Base to use for their specific requirements.  Note that the North American 

Energy Standards Board (NAESB) specifies a standard pressure base of 14.73 psia.  

Consequently many companies are adopting 14.73 as the standard pressure base for 

these calculations. 

ISO Configurations all use a base/reference pressure of 101.325 kPa. 

Air Summation Factor 

The Air Summation Factor is used in the calculation of the real relative density.  The 

current value of this property as specified in GPA Standard 2145-03 is 0.00523 and 

in GPA Standard 2145-09 is 0.00537. 

Cu. Ft. / lb – mol of Gas 

This setting is the number of cubic feet of volume occupied by one lb. mol. of an 

ideal gas at 14.696 psia and 60 degrees F.  It is used to calculate the Cu. Ft. 

Vapor/Gallon of Liquified Product.  The default value of 379.48357 is taken from 

GPA Standard 2186-02. 
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Water Settings for "Saturated" and "Wet" 
Calculations 

These settings are used when calculating "Saturated" and "Wet" results when water 

is included in the component list. 

Component Name:  If a component with this name exists in the component list, 

then "Saturated" results will be reported along with the "Dry" results.  If the mole% 

of this component in the analysis data is greater than 0, then "Wet" results will also 

be calculated based on that mole% value. 

 

Important: Important:  The compound name in the component list must match this Water 

Component Name exactly. 

 

Water Vapor Pressure:  The vapor pressure of water at 60 Deg. F:  0.25640 psia.  

This value was changed from 0.25636 in the GPA 2172-09 standard. 

Water Content Correlation:  the water content of a water-saturated gas at a 

specified flowing/saturation temperature and pressure can be calculated using the 

IGT RB 8 water content correlation that is described in the GPA 2172-09 standard.  

To enable this calculation, first check the “Prompt for flowing Temp. and Press.” 

checkbox and then check “Calculate GPA 2172-09 / IGT RB 8 Water Content 

Correlation. 

When these checkboxes are checked and the results processed, the Sample 

Information screen (shown below) will be displayed allowing you to enter the 

flowing temperature (in degrees F) and pressure (in psia).  The saturation water 

content will then be calculated for those conditions and displayed in the summary 

results section of the report under the “Wet (flowing)” column. 

Note: If you are processing results manually, you will need to select the “Tools > 

Edit Current Data Set…” menu option to display this dialog box and enter or change 

the flowing temperature and pressure. 

 
The Sample information screen that is displayed to allow you to enter the flowing temperature 
and pressure for the water content correlation calculation. 
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Raw Component Amount Units 

Select whether your GC results are calibrated and reported using Mole Percent, 

Weight Percent, or Liquid Volume Percent units.  If your chromatography data 

system reports component raw amounts as Weight%, then EZReporter will calculate 

the corresponding component Mole% from the Weight%.  Similarly, if your 

chromatography data system reports component raw amounts as Mole% or 

Volume%, then EZReporter will calculate the other normalized amounts. 

NGL/Extended Fraction Reporting 

Natural Gas Liquids (NGL)/Extended fraction (C6+) calculations involve 

renormalizing the extended fraction component amounts to 100% and then 

calculating the following results: 

 

Supported NGL/Extended Fraction Results 

C6+ Fraction: Total Raw Amount 

C6+ Fraction: Vapor Pressure 

C6+ Fraction: Relative Liquid Density (Specific gravity) 

C6+ Fraction: Liquid Density (lbm / gal.) 

C6+ Fraction: Liquid Density (lbm / bbl) 

C6+ Fraction: Volume (cu.ft. / gal.) 

C6+ Fraction: API Gravity 

C6+ Fraction: Avg. Molecular Weight 

C6+ Fraction: Gross Heating Value (BTU / cu.ft.) 

C6+ Fraction: Gross Heating Value (BTU / lbm) 

C6+ Fraction: Gross Heating Value (BTU / gal.) 

 

In addition, with “Combined” reports the extended components are also normalized 

with the standard components and the total results for the extended components are 

calculated and integrated into the standard report through the “combined 

component”, which is usually Hexanes Plus.  EZReporter supports combined reports 

that include the following results: 

 

Supported Results for NGL Combined Reports 

Total Raw Amount 

Total Normalized Mole% (Dry) 

Total Normalized Weight% 

Total Normalized Liquid Volume% 

Gross Heating Value, Ideal (Dry) 

Gross Heating Value (BTU / lbm) 

Gross Heating Value (BTU / gal.) 

Total Molecular Weight 

Total Vapor Pressure 

Total Relative Liquid Density (Specific Gravity) 

Total Liquid Density (lbm / gal.) 

Total Liquid Density (lbm / bbl) 

Total Volume (cu.ft. / gal.) 



 

62    Natural Gas Analysis   Diablo EZReporter Software 

API Gravity 

Important:  If you include total results other than those listed above in your 

combined report, those results will likely be incorrect. 

Selecting the NGL Calculation and Reporting 
Method 

The quickest way to get started with the EZReporter NGL/Extended Analysis and 

Report is to load and edit one of the default NGL configuration files.  Choose the 

default NGL configuration file that is designed for your desired extended calculation 

and reporting method. 

Note that all of these configuration files include all 169 components and their 

physical properties from the GPA TP17 standard (the standard range components use 

physical properties from the GPA 2145-09 standard).  However, you can delete, 

rename, and reorder the components to meet your needs. 

For additional information on configuring EZReporter NGL/Extended reports, see 

“Overview of NGL Configuration Window” on page 66. 

Extended – Separate Report 

With this calculation and reporting method, the extended fraction results are reported 

separately from the standard/total results.  The extended results are not integrated 

into the standard/total results. 

Default configuration file to use as a template: 

NGL Default (WtPct-Separate).cfg 

Extended – Combined Report 

With this calculation and reporting method the extended fraction results are reported 

separately and are also combined into the standard /total results through the specified 

combined component (usually Hexanes Plus). 

Default configuration file to use as a template: 

NGL Default (WtPct-Combined).cfg 

Extended – Combined Report with Raw Amount 
Correction 

This configuration file is the same as the “Extended – Combined” configuration, but 

it is also set up to correct the raw component amounts in the extended fraction using 

a correction (“bridge”) factor calculated from the iso-pentane and n-pentane amounts 

from the standard component range (usually from the TCD detector) and the 

extended component range (usually from the FID detector). 

Default configuration file to use as a template: 

NGL Default (WtPct-Combined-Corrected).cfg 
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Editing the Default Configuration 

To select and customize the default NGL configuration you must first open the 

EZReporter configuration editor by clicking the “Tools > Edit Configuration…” 

menu option. 

 
The EZReporter configuration editor 

Customizing the Configuration 

Next, perform the following steps: 

1. Load the configuration file described above that best matches your NGL 

calculating and reporting requirements by clicking the “Load” button. 

2. Before making any changes to the default configuration you should first save it 

to a different file name by clicking the “Save As” button.  This step is important 

to ensure that your customized configuration will not be reset to default settings 

if you ever reinstall or upgrade the software. 

3. Edit the component list to match your application as described in “Configuring 

the EZReporter Component List” on page 64.  Pay close attention to the 

important component naming requirements. 

4. Make any other changes to the NGL/C6+ configuration as described in 

“Overview of NGL Configuration Window” on page 66. 

5. Make any other changes to the configuration required for your application.  This 

may include customizing the results displayed in the report, changing the report 

header, setting up export options, etc.  Please refer to the EZReporter Reference 

manual for more information on this topic. 

6. Once you are finished customizing the configuration make sure to save your 

changes by clicking the “Save” button.  It is also a good idea to make backups 

of custom configurations in case you have a hard drive failure or other computer 

problem.  EZReporter provides an easy way to backup important configuration 

files by clicking the “Tools > Backup Current Configuration Files…” menu 
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option.  It is always best to save the configuration on a flash drive or external 

hard drive or network share. 

Configuring the EZReporter Component List 

It is unlikely that the component list included in the default configuration that you 

chose will meet the needs of your application exactly.  Fortunately, the component 

list can be modified easily.  To customize the component list you must first open the 

EZReporter configuration editor by clicking the “Tools > Edit Configuration…” 

menu.  If the “Components” tab isn’t already displayed, click that tab to display the 

component table. 

 

 
The EZReporter component configuration window 

Important Component Naming Requirements 

The two most important things to remember when configuring the EZReporter 

component list are: 

1. The component names used in the peak/calibration table and reports from 

the gas chromatography data system must match the spelling of the 

component names in the EZReporter component table. 

 

For example, if carbon dioxide is reported as “Carbon Dioxide” by the 

chromatography data system, it must also be listed in the EZReporter 

component table as “Carbon Dioxide” or “carbon dioxide”, not as “CO2”. 

 

2. The component names in EZReporter component table must all be unique. 

 

If you need to have multiple components with the same name, then append 

a numeric suffix or other unique character to the component name.  For 

example, in the “Extended – Combined with Raw Amount Correction” 

configuration described above, the “i-Pentane” and “n-Pentane” from the 

extended detector channel are entered into the component table as  “i-
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Pentane*” and “n-Pentane*” to differentiate them from the same 

components reported from the standard detector channel.  You could also 

use numeric suffixes like, “Nonanes1”, “Nonanes2”, “Nonanes3”, etc. 

 

Editing the Component list 

Here are additional instructions on how to customize the component list in the 

default configuration file you have chosen in order to meet the needs of your specific 

application. 

Deleting Components 

It is unlikely that you will need all of the extended components that are included in 

the default configuration.  To delete a component from the component list you 

simply select the desired row in the component table and either click the “Delete” 

button, or right-click on the row and select the “Delete selected component” from the 

pop-up menu that is displayed.  If you delete one of the standard range components 

(C1-C6+, N2, CO2, Etc.) then you will need to edit the “Last Standard Component” 

setting in the NGL/C6+ Configuration. 

Renaming Components 

As described above, it is important that the component names in the EZReporter 

component table match the component names reported by the chromatography data 

system.  To change the spelling of a component in the EZReporter component table, 

simple double-click on the desired component name and enter the new spelling. 

Duplicating Components 

If you want to duplicate an existing component, including all of its physical 

properties, simply select the row containing the component and the right click on the 

row and select “Clone selected component below”.  The selected component will be 

duplicated in the row immediately below.  Because component names must be 

unique, the cloned version of the component will have a “*” appended to the 

component name (or multiple “*” characters to ensure that the name is unique).  You 

are free to rename the duplicated component as long as it is still a unique name. 

If you add a new component to the standard component range (C1-C6+, N2, CO2, 

Etc.) then you may need to need to edit multiple settings in the NGL/C6+ 

Configuration, including the “Last Standard Component”, and “First Extended 

Component”, etc 

Changing the Component Order 

You can change the order of the components if necessary.  However, it is important 

that the components maintain the following relative order: 

The “standard” components (C1-C6+, N2, CO2, etc.) should be located at the top of 

the component table.  The order that they are listed in the table is the order that they 

will appear in the report.  The relative order of these components is not important.  

However, if you change the location of the bridge components (usually iC5 and nC5) 

or the combined component (usually C6+), then you may need to edit the NGL/C6+ 

configuration so that the correct components are selected for those settings.  See 

“Extended Report Format” on page 68 for more information. 

 

If your method is configured to perform the extended amount correction, then the 

“bridge” components for the extended fraction must be placed between the last 
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standard component and the first extended component so that they are not included 

in the calculations and report (see the screen capture below). 

 

The extended fraction components should be listed at the bottom of the component 

table – below the last standard component and extended fraction bridge components 

if they are present.  The relative order of the extended components is not important. 

 

 
Screen capture of the component table showing the relative order of the components. 

To change the order of a component in the component table, simply select the row in 

the table that contains the component you want to move and then click and hold the 

right mouse button while dragging the component to the new location in the table. 

Overview of NGL Configuration Window 

EZReporter is configured for the Natural Gas Liquids (NGL) extended calculations 

and reporting in the “NGL/C6+ Configuration” tab of the Natural Gas Analysis 

section of the configuration editor.  To display this window, first open the 

configuration editor by clicking the “Tools > Edit Configuration…” menu option.  

Next select the “Natural Gas Analysis” tab, and then the “NGL/C6+ 

Configuration” tab. 
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The NGL/Extended (C6+) Configuration Window 

Extended Report Control 

Check “Enable extended fraction reporting” to enable and configure the extended 

fraction (C6+) calculations and reports.  If you would like to have a summary table 

for the components in the extended fraction included when you print a report, then 

check “Print extended component summary”.  If you would like to print a total 

component report that includes the normalized mole%, weight%, and liquid 

volume% for all standard and extended range components, check “Print total 

component report”. 

Extended Fraction Report Format 

These two options determine how the extended fraction results will be displayed on 

the printed report relative to the total sample results.  If you choose “Report 

extended fraction results separately from sample results”, then the extended 

fraction results will be appended to the results table below the sample results.  If you 

choose, “Link extended fraction results to corresponding sample results”, then 

the extended fraction results will be displayed in additional columns to the right of 

the corresponding total sample results. 

Extended Fraction Component Range 

These options are used to define the components that will be included in the 

standard/total report, and the components that will be included in the extended 

fraction report. 

Last Component in STD Report:  Select the last component to include in the 

standard/total report.  This will usually be Hexanes Plus (C6+). 

First Component in C6+ Report:  Select the first component in the extended 

(C6+) fraction.  This will usually be 2,2-Dimethylbutane.  Note that all components 

after this component in the component list will be included in the extended fraction 

calculations and report. 
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Extended Report Format 

These options are used to define how the extended fraction (C6+) results will be used 

in the calculation and report.  There are two options: 

Separate:  With this method, the extended fraction is only reported separately from 

the standard/total results.  The extended results are not integrated into the 

standard/total results.  Consequently, the GC method and calibration must include 

Hexanes Plus in the standard portion of the report (usually from the TCD detector 

channel) as in a normal natural gas analysis report. 

If you check, “Use extended fraction results for C6+ calculation constants”, then 

the extended fraction results will be used as the physical constants for C6+ in the 

total sample calculations in place of the constants in the component table. 

Here are the extended fraction results that are calculated and can be reported: 

 

Supported NGL/Extended Fraction Results 

C6+ Fraction: Total Raw Amount 

C6+ Fraction: Vapor Pressure 

C6+ Fraction: Relative Liquid Density (Specific gravity) 

C6+ Fraction: Liquid Density (lbm / gal.) 

C6+ Fraction: Liquid Density (lbm / bbl) 

C6+ Fraction: Volume (cu.ft. / gal.) 

C6+ Fraction: API Gravity 

C6+ Fraction: Avg. Molecular Weight 

C6+ Fraction: Gross Heating Value (BTU / cu.ft.) 

C6+ Fraction: Gross Heating Value (BTU / lbm) 

C6+ Fraction: Gross Heating Value (BTU / gal.) 

 

Combined:  With this method the extended fraction results are reported separately 

and are also combined into the standard /total results through the specified combined 

component (Usually Hexanes Plus).  Here are the standard/total results that can be 

used in a combined report: 

 

Supported Results for NGL Combined Reports 

Total Raw Amount 

Total Normalized Mole% (Dry) 

Total Normalized Weight% 

Total Normalized Liquid Volume% 

Gross Heating Value, Ideal (Dry) 

Gross Heating Value (BTU / lbm) 

Gross Heating Value (BTU / gal.) 

Total Molecular Weight 

Total Vapor Pressure 

Total Relative Liquid Density (Specific Gravity) 

Total Liquid Density (lbm / gal.) 

Total Liquid Density (lbm / bbl) 

Total Volume (cu.ft. / gal.) 

API Gravity 
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Extended Fraction Raw Amount Correction 

Combined reports have an additional option that allows the extended fraction 

component raw amounts to be corrected prior to normalizing.  The correction 

(“bridge”) factor is calculated from the raw amount ratio of one or two sets of bridge 

components.  The correction assumes that the bridge component(s) in the extended 

fraction should have the same raw concentration as the corresponding component(s) 

in the standard fraction.  The calculated correction factor is then applied to all of the 

component raw amounts in the extended fraction prior to their use in the combined 

report calculations. 

Additional Extended Fractions 

 

The “Additional Ext. Fractions” table allows you to define additional extended 

fraction ranges that can be calculated and reported in addition to the C6+ fraction. 

To define an additional extended fraction, click the “Add” button to define the 

name/caption of an extended fraction, and then select the components to include in 

the extended fraction. 

If you want to include the additional extended fraction in the printed report, make 

sure to check, “Include in Report”. 

Make sure to check the “Save” button to save the extended fraction settings. 
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You can use right-click context menu options to assist with selecting large extended 

component ranges. 

1. You can ctrl-click and/or shift-click to select the desired list of components 

and then right click and choose “Check all selected components” from the 

context menu.  You can also “Uncheck all selected components”. 

 

2. You can right click a component and then select “Check all remaining 

components” from the context menu to check all components below the 

selected component in the table.  Similarly, you can choose to “Uncheck all 

remaining components”. 

 

3. You can uncheck all components by selecting “Uncheck all components” 

from the context menu. 

The Results Database 

Overview of the Results Database 

The Results Database is an optional add-on for the Diablo EZReporter software that 

allows you to capture results and save them in a local SQLite database.  A few of the 

capabilities of the Results Database are listed below. 
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 Sample results including sample information, individual component results, 

and calculated natural gas analysis (NGA) results can be added to a local 

results database. 

 Sample results in the database can be searched and batch reprocessed (for 

printing reports, creating history plots, or exporting results). 

 Statistics including average, standard deviation, %RSD, maximum, and 

minimum are calculated and displayed when performing sample name 

searches. 

 A results comparison window can be used to compare the component 

normalized mole% values between two samples using either the GPA 2261 

repeatability or reproducibility limits (or any other limits entered by the 

user). 

 Each result in the database has a “Status” field that can be set to “None”, 

“Accept”, or “Reject” status.  The status field can then be used in searches 

or batch reprocessing to filter which results are selected. 

 You can enable a result confirmation screen that displays the current 

monitored parameters and their alarms and allows you to “Accept”, 

“Reject” or “Cancel” the result before it is added to the database.  In 

addition, you can enter a result comment from a pre-filled list of comment 

strings. 

Configuring the Results Database 

The Results Database uses a self-contained, serverless, zero-configuration, SQLite 

database that is stored on the local hard drive.  There is no complex database setup or 

configuration required. 

The “Results Database” tab of the configuration editor allows you to set up the 

EZReporter to add results to the database automatically as well as to check the status 

of the database and perform database maintenance functions. 

 
The Results Database tab of the configuration editor. 



 

72    The Results Database   Diablo EZReporter Software 

Database Status 

License Status:  Displays the license status for the results database. 

Database Version:  Displays the current version of the database. 

Schema Version:  an internal version resource that is incremented whenever the 

database schema is modified. 

Number of results in database:  The number of results that are currently present in 

the results database. 

Database file size:  The physical size of the ‘Results.db’ database file on disk. 

Database Maintenance 

The buttons in the “Database Maintenance” section of the Results Database 

configuration window are used to perform the maintenance activities listed below. 

Activate License:  This button is enabled if the Results Database license has not 

been activated.  It displays the license activation dialog that allows you to activate 

this feature. 

Cleanup:  Compresses and re-indexes the database file.  This is most often used to 

reclaim space (and reduce the database file size) taken up by deleted database results 

records. 

Backup:  Backs up the current results database.  The format of the backup file is 

“Results-YYYYMMDD-HHMMSS.db”, where “YYYYMMDD” is the current date, 

and “HHMMSS” is the current time.  Backup files are saved in the EZReporter 

installation folder. 

Check Integrity:  Performs a check of the integrity of the database.  It looks for out-

of-order records, missing pages, malformed records, and corrupt indices. 

Results Processing 
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Save automatically processed results:  If you check the “Save automatically 

processed results…” check box, then results that are processed automatically from 

one of the supported data systems will be added automatically to the results database. 

Display confirmation window:  If you check “Display confirmation window”, 

the result confirmation dialog box is displayed before the result is added to the 

results database.  This dialog box re-displays the parameter monitor table with all of 

the alarm limits visible.  Clicking the “Accept” or “Reject” buttons will cause the 

result to be added to the database with the corresponding result status.  Clicking 

“Cancel” will cancel adding the result to the database.  Any text that is entered into 

the Result Comments box will be saved in the “ResultComments” database field for 

that result. 

Note: You can have a set of pre-defined result comments loaded automatically into 

the Result Comments list box by adding those comments to a file named, 

‘ResultComments.dat”.  If this file is found in the EZReporter installation folder, 

each line of text present in the file will be added as a separate item in the list box. 

 
The Result Confirmation Screen that allows you to review the results before adding them to 
the results database. 

Display Sample History:  Check “Display Sample History” If you would like to 

display the sample history for automatically processed results.  The history is 

retrieved from the Results Database based on the Sample Name of the result.  You 

can limit the number of results that are displayed in the sample history, and you can 

filter the results further based on the results status. 

The Results Database Window 
If the Results Database has been licensed or is still in trial mode, then the Results 

Database tab will be visible on the main software window.  The Results Database 

window is divided into two main sections:  the “Sample Results Summary” table and 

the “Selected Sample Detail” table. 
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The Results Database window of the EZReporter Software. 

When you click on a result in the Sample Results Summary table, the detailed results 

for that sample are displayed in the “Selected Sample Detail” tables below. 

Sample Results Summary Table 

The Sample Results Summary Table displays the results that have been selected 

using the “Find results” dialog.  The summary table takes one of two forms.  When 

results from multiple samples with different sample names are displayed, then only 

summary sample information is displayed in the table.  When results with a single 

sample name are displayed, then the summary table displays summary statistics 

(average, standard deviation, %RSD, maximum, and minimum) for a number of 

component and NGA results to allow you to evaluate the result history for that 

particular sample. 

Multiple Sample Summary 
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Single Sample Summary 

 

Note:  If you have disabled NGA calculations (see “Disable Natural Gas Analysis 

Calculations and Reporting” on page 58), then the Single Sample Summary table 

will not include any of the natural gas analysis results. 

Selected Sample Detail Tables 

When you click on a result in the Sample Summary table, detailed results for that 

sample are displayed in the three Selected Sample Detail tables. 

Sample Information Detail 

This table contains the sample information fields for the selected sample. 

 

Component Results Detail 
This table contains the component results for the selected sample.  If you have 

disabled NGA calculations (see “Disable Natural Gas Analysis Calculations and 

Reporting” on page 58), then the Component Results Detail table will not include 

any of the natural gas analysis results. 

 

NGA Results Detail 

This table contains the natural gas analysis (NGA) results for the selected sample.  If 

you have disabled NGA calculations (see “Disable Natural Gas Analysis 

Calculations and Reporting” on page 58), then the NGA Results tab will not be 

displayed. 
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Using the Results Database 

Selecting and Deselecting Results 

 

Important: The database menus and dialogs differentiate between “selecting” a result and 

“highlighting” a result.  “Selecting” a result means that you have checked the 

“Select” checkbox in the first column of the line containing the result.  

“Highlighting” a result means that you have clicked on a particular line in the result 

table, causing it to be highlighted. 

 

You can click, control-click, and shift-click to highlight results in the Sample Results 

Summary table and the “select” them by right-clicking and using one of the context 

menu options: 

 

Generating a Report for a Selected Result 

To generate a report for a result in the database, simply highlight it by clicking on the 

row containing the result in the Sample Results Summary table, and then click the 

“Report” button at the bottom of the Window.  The Report Options window will be 

displayed. 
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If the “Recalculate Results” checkbox is left unchecked, then the results will be 

displayed as they were calculated for the original report.  If you check “Recalculate 

Results”, you will then have the option of using the currently loaded configuration 

file settings, or the original configuration file settings (if available) for the 

calculations. 

The selected results are then transferred to the main “Sample Results” window, and 

you can treat the report just as if had been loaded from disk or processed from a 

chromatography data system. 

Batch Processing Multiple Results 

Multiple results can be batch processed by first selecting the desired results in the 

Sample Results Summary table (the check box in the first column must be checked).  

Next click the “Batch” button to display the Batch Process Results dialog box. 

 
The Batch Process Results dialog box. 

Batch Process Selected results 

You can choose to batch print, batch export, and/or plot the selected results by 

checking the appropriate checkbox. 

During batch processing each selected result is transferred back to the main Sample 

Results window and then printed, exported, and/or plotted in the parameter history 

window. 
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Processing Options 

The current configuration settings, including the export settings and parameter 

history settings will be used to process the results unless you check the “Load 

original configuration if available” checkbox.  If you enable this option, the original 

configuration file used to generate each result will be loaded and used if it is 

available. 

If you check the “Reprocess results” check box, then all of the natural gas analysis 

results will be recalculated using the specified configuration file.  If this box is left 

unchecked, then the results will be printed/exported as originally reported.  You 

would enable this option if you wanted to reprocess results after making changes to 

physical property values, etc. 

Finding Results in the Database 

Click the “Find Results” button to select the results to display in the Sample 

Summary table. 

 
The Select results dialog box. 

Retrieve All Results 

This option will retrieve all results from the database and display them in the Sample 

Results Summary table.  The number of results currently in the database is displayed 

in parenthesis). 

Find by Sample Name 

The Sample Name list box is pre-filled with all of the sample names that are present 

in the current database.  You can either select a sample name from the list, or type a 

sample name into the list box. 

A sample name search returns all samples in the database that have the specified 

sample name.  The Sample Results Summary table will be configured to compare the 
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results of these samples by calculating and displaying summary statistics.  See 

“Sample Results Summary Table” on page 74 for more information. 

You can limit the number of results displayed in the sample history by entering a 

value > 0 in the “Limit sample history” field. 

Results ID 

Enter the database results ID for the specific result you want to find. 

Filters 

A number of filters can be enabled to refine your search.  Each of the following 

filters acts on the results retrieved using the options above. 

Results Status Filter 

You can filter the results that are returned from the search based on setting of the 

results status field for each result (“None”, “Accept”, or “Reject”). 

Export Status Filter 

You can filter the results that are returned from the search based on setting of the 

Export Status field for each result.  The export status field is changed from 0 (result 

not exported) to 1 (result exported) when the result has been saved to an export file 

using the batch export feature of the results database. 

Date Filter 

You can filter the results that are returned from the search based on either the 

injection date or the report date (which is usually the date the result was added to the 

results database).  You can specify both a starting and ending date range. 

Comparing Results 

The results comparison window can be used to compare the component normalized 

mole% values between two samples using either the GPA 2261 repeatability or 

reproducibility limits (or any other limits entered by the user). 

First select the two sample results you want to compare by clicking the “Select” 

check box in the first column of the Sample Summary results table.  Note that if 

more than two results are selected, only the first two in the table will be compared.  

Next, check the “Compare” button. 
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The Compare Results window. 

The %Difference for the two results is calculated as: 

% Difference =ABS[ ((Result 1 – Result 2) / (Result 2)) * 100] 

You can press the “Swap 1 > 2” button to do the reverse comparison.  You can also 

switch between repeatability and reproducibility limits by clicking the desired limit 

option. 

The component repeatability and reproducibility limits are entered into the 

component configuration table.  See “Repeatability and Reproducibility Limits” on 

page 25. 

Note:  If you have disabled NGA calculations (see “Disable Natural Gas Analysis 

Calculations and Reporting” on page 58), then raw component amounts will be used 

for the comparison instead of the normalized component amounts. 

Deleting Results from the Database 

Select the result(s) that you want to delete by checking the “Select” checkbox for 

each result and then press the “Delete” button.  In order to reduce the size of the 

database file after deleting records, you must also click the “Cleanup” button in the 

database maintenance options of the configuration editor. 
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Adding Results to the Database 

There are three ways to add results to the Results Database: 

1. Enable the option to add automatically processed results from the 

chromatography data system to the database.  See “Results ” on page 72. 

2. With the desired result displayed in the main Sample Results window, 

select the “Save to Results Database” option of the main “File” menu. 

3. Import results from a comma- or tab-delimited text file. See “Importing 

Results into the Database” on page 81. 

Importing Results into the Database 

You can import results from a comma- or tab-delimited text file into the Results 

Database using the “Import Results” option. 

The source text file must contain one result per line with each value separated by a 

comma or tab.  An Import Template file is used to specify the order of the 

columns/fields in the Import Data File and how those fields/columns map into the 

database. 

When you click the “Import” button, the following dialog box is displayed.  You can 

select the Import Template File and Import Data File by clicking the respective 

browse button.  You can open the Import Template File in Windows Notepad to edit 

the template file by clicking the corresponding notepad button. 

 
The Results Database Import dialog box. 

Import Options 

You can choose to append the imported results to the current database, or replace all 

of the current results with the imported results.  You can also choose to set the 

Export Status for each result to “Already Exported” if you don’t want the imported 

results to be re-exported. 

Importing 

When you click the import button, the import progress is displayed in the progress 

bar at the bottom of the dialog box.  Press the “Cancel” button to cancel the import. 
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Important:  Canceling an Import does not delete results that have already been added 

to the database.  If you want to delete those records that have already been added, 

you must use the “Delete” option.  See “Deleting Results from the Database” on 

page 80. 

 

Details on creating the Import Template file can be found in the Appendix.  See 

“Results Database Import Template Format” on page 100. 

Upgrading the Results Database Format 
As new features and capabilities are added to the Results Database in future versions 

of the software, the database format (schema) may change.  However, the software 

has been designed to detect when you are using an older version of the database 

format and will allow you to upgrade the database to the latest format automatically 

without affecting your data. 

After installing a new version of the software, the following message will be 

displayed when the software is started if it detects that you are using an older version 

of the database format. 

 

Note:  the current version of the Results Database you are using is displayed in the 

“Results Database Status” table in the Results Database tab of the configuration 

Editor (see “Database Status” on page 72). 

After clicking the “OK” button, the following “Upgrade Results Database” window 

will be displayed.  Press the “Start Upgrade” button to upgrade your existing 

database to the latest version.  Note that your current database will be backed up 

automatically so that it can be restored if any errors are detected during the upgrade 

process. 
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You can also choose to “Cancel” the database upgrade.  However, the results 

database will be disabled if you choose to do so.  You will be prompted to upgrade 

the database each time you start EZReporter until the database has been upgraded 

successfully. 

 

The progress of the upgrade is logged to the window.  Note that some of the upgrade 

steps may take several seconds to complete, particularly if your existing database is 

very large. 

 

At the end of the upgrade process a message will be displayed indicating whether or 

not the upgrade was successful.  The upgrade log is saved automatically to the file, 

“results_database_upgrade_log.txt”, which is located in the software installation 

folder. 

If the database was not upgraded successfully, then the results database will be 

disabled until the problem can be found and fixed.  Please contact support in this 

case to assist you in determining the problem.  You will probably be asked to send 

your results database file and the upgrade log file to support. 



 

84    The Results Database   Diablo EZReporter Software 
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Appendix 

EZReporter Data File Format 

EZReporter data files are comma-delimited text files that can be imported into LIMS 

or process data systems.  An example file is listed below. 

 

Hint: Hint: Although the EZReporter data files are text files that can be used directly to 

send results to other customers or databases, Export files are a much better, more 

flexible way to do this.  See “Data Export” on page 35 for more information on 

Export Templates and Export Files. 

 

 

SampleName,"GPA 2172-96 Example Calculation" 

MethodName,"" 

UserName,"" 

Comments,"Gas properties at 60 Deg. F and 14.696 psia 

(Gas Analysis on Dry Basis)" 

InjectionTime,"" 

SettingsFile,"C:\Program Files\ Diablo 

EZReporter\Settings\GPA 2172-96 Wet.cfg" 

ProcessMode,3 

DataSource,1 

Instrument,"" 

SampleInfo1,"1456" (optional) 

SampleInfo2,"82" (optional) 

SampleInfo3,"" (optional) 

SampleInfo4,"" (optional) 

,,"Component","Ret.Time","Peak Area","Unnormalized 

Mole%","Normalized Mole%","Gross Heating Value","Molar 

Mass Ratio","Summation Factor" 

Component,1,"Helium",0.000,0,0.03,0.03,0,0.00004146,0 
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Component,2,"Nitrogen",0.000,0,0.32,0.32,0,0.003095136,0

.00001408 

Component,3,"Carbon 

Dioxide",0.000,0,2.02,2.02,0,0.03069592,0.00039794 

Component,4,"Methane",0.000,0,83.02,83.02,838.502,0.4598

64384,0.00963032 

Component,5,"Ethane",0.000,0,7.45,7.45,131.84265,0.07734

59,0.00178055 

Component,6,"Propane",0.000,0,4.39,4.39,110.45679,0.0668

4214,0.00151016 

Component,7,"i-

Butane",0.000,0,0.83,0.83,26.99077,0.01665644,0.00038014 

Component,8,"n-

Butane",0.000,0,1.08,1.08,35.23284,0.02167344,0.00051624 

Component,9,"i-

Pentane",0.000,0,0.31,0.31,12.40279,0.00772272,0.0001801

1 

Component,10,"n-

Pentane",0.000,0,0.25,0.25,10.02225,0.006228,0.00015775 

Component,11,"n-

Hexane",0.000,0,0.3,0.3,14.2677,0.0089265,0.0002406 

SumHV,1179.71779 

SumMolarMass,0.69909204 

SumZ,0.01480789 

RawTotalMolePct,100 

PressureBase,14.696 

WaterMoleFractionSat,1.74442025040827E-02 

GrossHeatingValueIdealDry,1179.71779 

GrossHeatingValueRealDry,1183.53165556816 

GrossHeatingValueIdealSat,1159.13855397357 

GrossHeatingValueRealSat,1163.31848048984 

RealRelativeDensityDry,0.701094431772844 

RealRelativeDensitySat,0.700006424492229 

GasCompressibilityFactorDry,0.996777555082519 

GasCompressibilityFactorSat,0.996406894082425 

Export Template Format 

Export templates are plain-text files with a “.btx” file extension that are used to 

define how results will be saved to the text files created by the export feature of the 

EZReporter software.  Any text editor like Windows Notepad can edit export 



 

  Diablo EZReporter Software Appendix    87 

template files.  However, make sure they are saved with the “.BTX” file extension 

(Notepad will sometimes append a “.TXT” file extension to the end of the “.BTX” 

extension.) 

The export function will replace any "variables" it finds within the export template 

file with the current value of the variable.  Variables are pre-defined names enclosed 

between braces: {VariableName}. 

Note:  The template examples shown below are included in the template file, 

“Example Export Template.btx”. 

 

Any other text that is present in the template file will be exported "as is" unless it is 

part of a comment or other special template section. 

 

{StartComment} 

Any text present between {StartComment} and 

{EndComment} will not be saved to the export file.  

Comments can be used to annotate the template file. 

{EndComment} 

 

The lines between StartHeader and EndHeader will only be saved to a new export 

file.  They will not be saved when new results are appended to an existing export 

file. This can be used to create a column header for a summary list of results from 

multiple runs, for example. 

 

{StartHeader} 

Date, Name, Ret. Time, Area, Mole% 

{EndHeader} 

 

"DecimalPlaces" is a special variable used to set the number of decimal places to 

include for calculated results (4 places in this example).  It affects the results that are 

exported after its place in the template.  Note that the default value is the number of 

decimal places specified in the Data Files configuration. 

Note:  It is generally best to change the number of decimal places to report using the 

option in the Data Files section of the EZReporter configuration editor rather than 

the “Decimal Places” variable. 

 

{DecimalPlaces,4} 

 

To create a comma-delimited export file, simply include commas between the fields 

you wish to separate.  In addition, if you want quotation marks to enclose text fields, 

simply include them in the template as shown below. 

 

"CurrentDate", "{Now}" 
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"SampleName", "{SampleName}" 

"UserName", "{UserName}" 

 

To create a tab-delimited file, simply use the tab key on your keyboard, or include 

the special tab variable, "Tab", between the fields you wish to separate as shown 

below. 

 

CurrentDate {Now} 

SampleName {SampleName} 

UserName {UserName} 

 

or 

 

MethodName{Tab}{MethodName} 

SettingsFile{Tab}{SettingsFile} 

InjectionTime{Tab}{InjectionTime} 

 

You can use the special component loop to print the component-specific results 

(Name, Mole%, Area, etc.) for all of the components in the current configuration.  

The components are exported in the same order that they appear in the configuration 

editor. 

 

{StartCompLoop} 

{CompName},{CompRT},{CompArea},{CompNormMolePct} 

{EndCompLoop} 

 

If instead, you want to export the results for a specific component, simply include the 

component number in the variable as shown below. Components are numbered in the 

order they appear in the configuration editor, starting with 1 for the first component. 

 

Component 1 Name:  {CompName,1} 

Component 1 Mole%: {CompNormMolePct,1} 

 

You can use the special line continuation variable, "_", to force the next line in the 

template to be appended to the current line instead of in a new line: 

 

{CompName,1},{_} 

{CompName,2},{_} 
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{CompName,3} 

 

Line continuation is most useful in instances where you want all of the results to 

appear in a single line.  For example, you would use the line continuation in a 

component loop to create a summary export file in which each line corresponds to a 

single run. 

 

{StartCompLoop} 

{CompName},{CompRT},{CompArea},{CompNormMolePct},{_} 

{EndCompLoop} 

Summary of Export Template Variables 

You can view a list of the variables that are supported by Export Templates at any 

time by selecting either the “Tools > Show Export Template Variables…” menu 

option, or by clicking on the “Show” button in the Export section of the 

configuration editor.   

 
EZReporter Template Variable Table 

Hint: Hint:  If you double-click on a particular variable in the table, it will be copied to the 

Windows clipboard so that you can paste it into a template file. 
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Export Variable Format Strings and Scale Factors 

Optional formatting strings and scaling factors can be specified for export variables 

to increase flexibility. 

 

Important: Important:  The use of formatting strings and scaling factors is an advanced feature 

and should only be utilized when export file requirements dictate. 

 

The export variable syntax is shown below: 

{VariableName, [PARAMETER], [FORMAT], [SCALEFACTOR]} 

VariableName:  The name of the variable. 

[PARAMETER]:  An optional parameter value that is required for some variables. 

[FORMAT]:  A special format string that instructs the export engine on how to 

format the variable value before writing it to the export file. 

[SCALEFACTOR]:  If the variable is numeric, it will be multiplied by the specified 

scaling factor prior to formatting and writing the result to the export file. 

The following table describes the special characters used to make up a format string. 

 

Format 
Character 

Description 

Numeric Formatting 

0 Digit placeholder. Display a digit or a zero. If the variable has a digit in 

the position where the 0 appears in the format string, display it; otherwise, 
display a zero in that position. 

# Digit placeholder. Display a digit or nothing. If the variable has a digit in 

the position where the # appears in the format string, display it; otherwise, 

display nothing in that position. 

. Decimal placeholder.  The decimal placeholder determines how many 

digits are displayed to the left and right of the decimal separator. If the 

format expression contains only number signs to the left of this symbol, 

numbers smaller than 1 begin with a decimal separator. To display a 

leading zero displayed with fractional numbers, use 0 as the first digit 

placeholder to the left of the decimal separator. 

Text String Formatting 

@ Character placeholder. Display a character or a space. If the string has a 

character in the position where the “at” symbol (@) appears in the format 
string, display it; otherwise, display a space in that position. 

& Character placeholder. Display a character or nothing. If the string has a 

character in the position where the ampersand (&) appears, display it; 
otherwise, display nothing. 

Date Formatting 

d Display the day as a number without a leading zero (1 – 31). 

dd Display the day as a number with a leading zero (01 – 31). 

m Display the month as a number without a leading zero (1 – 12). 

mm Display the month as a number with a leading zero (01 – 12). 

yy Display the year as a 2-digit number (00 – 99). 

yyyy Display the year as a 4-digit number (100 – 9999). 
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Time Formatting 

h Display the hour as a number without leading zeros (0 – 23). 

Hh Display the hour as a number with leading zeros (00 – 23). 

N Display the minute as a number without leading zeros (0 – 59). 

Nn Display the minute as a number with leading zeros (00 – 59). 

S Display the second as a number without leading zeros (0 – 59). 

Ss Display the second as a number with leading zeros (00 – 59). 

The following table shows a few examples of format strings and scaling factors. 

 

Variable Variable Value Value Exported 

{CompRawMolePct,1,0.000} 1.523446 1.523 

{CompRawMolePct,1,0.000} 85.67234 85.672 

{CompRawMolePct,1,00000,1000} 85.67234 85672 

{CompArea,2,00000000} 1234 00001234 

{InjectionTime} 10/12/2004 1:08:13 PM 10/12/2004 1:08:13 PM 

{InjectionTime,,mmddyyyy} 10/12/2004 1:08:13 PM 10122004 

{InjectionTime,,HhNn} 10/12/2004 1:08:13 PM 2013 

{SampleName,,@@@@@@@@} Sample Name Sample N 

{SampleName,,@@@@@@@@} RC1 RC1***** 

 * = a space character 

Full List of Export Template Variables 

The following table lists all of the variables that are supported by EZReporter’s 

Export Templates. 

 

Hint: Hint:  The most up to date list of export template variables can always be viewed 

and printed by clicking the “Tools > Show Export Template Variables…” menu 

option. 

 

 

Export Variable Export Variable Description 

Component Result Variables 

CompNum The current component number being 

processed in a component loop. 

CompName The name of the component. 

CompRT The retention time of the component as 

reported by the data system. 

CompArea The integrated peak area of the 

component as reported by the data 

system. 

CompRawAmount The concentration of the component as 

reported by the data system. 

CompNormAmount The normalized amount of the component 

calculated by normalizing all of the raw 
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component concentrations to 100%.  For 

NGA applications this is the dry 

normalized mole% (water content 

exlcuded). 

CompNormMolePctSat The normalized mole percent of the 

component calculated by normalizing all 

of the raw component concentrations to 

100%.  Corrected for the saturated water 

mole percent. 

CompNormMolePctWet The normalized mole percent of the 

component calculated by normalizing all 

of the raw component concentrations to 

100%.  Corrected for the actual water 

mole percent if it has been entered. 

CompWeightPctDry The normalized weight percent of the 

component in a dry gas. 

CompWeightPctSat The normalized weight percent of the 

component in a water-saturated gas. 

CompWeightPctWet The normalized weight percent of the 

component in a wet gas. 

CompVolumePctDry The normalized liquid volume percent of 

the component in a dry gas. 

CompGrossHvDry The calculated gross heating value 

(BTU/cu.ft.) of the component in an ideal, 

dry gas. Corrected for pressure base.  

CompGrossHvSat The calculated gross heating value 

(BTU/cu.ft.) of the component in an ideal, 

water-saturated gas.  Corrected for 

pressure base. 

CompGrossHvWet The calculated gross heating value 

(BTU/cu.ft.) of the component in a ideal, 

wet gas.  Corrected for pressure base. 

CompNetHvDry The calculated net heating value 

(BTU/cu.ft.) of the component in an ideal, 

dry gas. Corrected for pressure base.  

CompNetHvSat The calculated net heating value 

(BTU/cu.ft.) of the component in an ideal, 

water-saturated gas.  Corrected for 

pressure base. 

CompNetHvWet The calculated net heating value 

(BTU/cu.ft.) of the component in a ideal, 

wet gas.  Corrected for pressure base. 

CompGrossHvLBMDry The calculated gross heating value 

(BTU/lbm) of the component in a dry gas. 

CompGrossHvLBMSat The calculated gross heating value 

(BTU/lbm) of the component in a water-

saturated gas. 

CompGrossHvLBMWet The calculated gross heating value 

(BTU/lbm) of the component in a wet 

gas. 

CompNetHvLBMDry The calculated net heating value 

(BTU/lbm) of the component in a dry gas. 

CompNetHvLBMSat The calculated net heating value 

(BTU/lbm) of the component in a water-
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saturated gas. 

CompNetHvLBMWet The calculated net heating value 

(BTU/lbm) of the component in a wet 

gas. 

CompGrossHvGalDry The calculated gross heating value 

(BTU/gal.) of  the component in a dry 

gas. 

CompRelDensity The calculated relative density (Xi * Gi) 

of the current component in a dry gas. 

CompRelDensitySat The calculated relative density (Xi * Gi) 

of the current component in a water-

saturated gas. 

CompRelDensityWet The calculated relative density (Xi * Gi) 

of the current component in a wet gas. 

CompGasDensity The calculated ideal gas density 

(lbm/cu.ft.) of this component in a dry 

gas. 

CompGasDensitySat The calculated ideal gas density 

(lbm/cu.ft.) of this component in a water-

saturated gas. 

CompGasDensityWet The calculated ideal gas density 

(lbm/cu.ft.) of this component in a wet 

gas. 

CompCompressibility The calculated compressibility (Xi * bi) 

of the current component in a dry gas. 

CompCompressibilitySat The calculated compressibility (Xi * bi) 

of the current component in a water 

saturated gas. 

CompCompressibilityWet The calculated compressibility (Xi * bi) 

of the current component in a wet gas. 

CompGPM The calculated GPM (Gal./1000 cu.ft.) of 

the component in a dry gas.  Corrected for 

pressure base. 

CompGPMSat The calculated GPM (Gal./1000 cu.ft.) of 

the component in a water saturated gas.  

Corrected for pressure base. 

CompGPMWet The calculated GPM (Gal./1000 cu.ft.) of 

the component in a wet gas.  Corrected 

for pressure base. 

CompMWDry The calculated molecular weight of the 

component in a dry gas. 

CompMWSat The calculated molecular weight of the 

component in a water saturated gas. 

CompMWWet The calculated molecular weight of the 

component in a wet gas. 

CompVPDry The calculated vapor pressure of the 

component in a dry gas at 100 degrees F. 

CompRelLiqDensityDry The calculated relative liquid density of 

the component in a dry gas. 

CompAbsLiqDensityDry The calculated liquid density (lbm/gal.) of 

the component in a dry gas. 

Total/Summary Result Variables 

TotalRawAmount The total raw amount, including water if 

it has been entered. 



 

94    Appendix   Diablo EZReporter Software 

TotalRawMolePct The total raw mole percent (excluding 

water) 

TotalNormAmount The total normalized amount (should 

always be 100%) 

TotalNormMolePct The total normalized mole pct for a dry 

gas (should always be 100%) 

TotalNormMolePctSat The total normalized mole pct for a 

water-saturated gas (should always be 

100%) 

TotalNormMolePctWet The total normalized mole pct for a wet 

gas (should always be 100%) 

TotalNormWeightPctDry The total normalized weight percent for a 

dry gas (should always be 100%) 

TotalNormWeightPctSat The total normalized weight percent for a 

water a saturated gas (should always be 

100%) 

TotalNormWeightPctWet The total normalized weight percent for a 

wet gas (should always be 100%) 

TotalNormVolumePctDry The total normalized liquid volume 

percent for a dry gas (should always be 

100%) 

SumCompressibility The calculated sum of component 

compressibility values (Sum Xi * bi) for a 

dry gas. 

SumCompressibilitySat The calculated sum of component 

compressibility values (Sum Xi * bi) for a 

water saturated gas. 

SumCompressibilityWet The calculated sum of component 

compressibility values (Sum Xi * bi) for a 

wet gas. 

PressureBase The Pressure Base used in the 

calculations. 

FlowingTemperature The flowing temperature in degrees F. 

FlowingPressure The flowing pressure in psia. 

WaterMoleFractionWet The water mole fraction if it has been 

entered or has been calculated by the 

water content correlation. 

WaterMoleFractionSat The water mole fraction calculated for 

saturated conditions at the base 

temperature and base pressure. 

GrossHvIdealDry The total gross heating value (BTU/cu.ft.) 

for an ideal, dry gas. 

GrossHvIdealSat The total gross heating value (BTU/cu.ft.) 

for an ideal, water saturated gas. 

GrossHvIdealWet The total gross heating value (BTU/cu.ft.) 

for an ideal, wet gas. 

GrossHvRealDry The total gross heating value (BTU/cu.ft.) 

for a real, dry gas 

GrossHvRealSat The total gross heating value (BTU/cu.ft.) 

for a real, water saturated gas. 

GrossHvRealWet The total gross heating value (BTU/cu.ft.) 

for a real, wet gas. 

GrossHvLBMDry The total gross heating value (BTU/lbm) 

for a dry gas. 
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GrossHvLBMSat The total gross heating value (BTU/lbm) 

for a water-saturated gas. 

GrossHvLBMWet The total gross heating value (BTU/lbm) 

for a wet gas. 

NetHvIdealDry The total net heating value (BTU/cu.ft.) 

for an ideal, dry gas. 

NetHvIdealSat The total net heating value (BTU/cu.ft.) 

for an ideal, water saturated gas. 

NetHvIdealWet The total net heating value (BTU/cu.ft.) 

for an ideal, wet gas. 

NetHvRealDry The total net heating value (BTU/cu.ft.) 

for a real, dry gas 

NetHvRealSat The total net heating value (BTU/cu.ft.) 

for a real, water saturated gas. 

NetHvRealWet The total gross heating value (BTU/cu.ft.) 

for a real, wet gas. 

NetHvLBMDry The total net heating value (BTU/lbm) for 

a dry gas. 

NetHvLBMSat The total net heating value (BTU/lbm) for 

a water-saturated gas. 

NetHvLBMWet The total net heating value (BTU/lbm) for 

a wet gas. 

IdealRelDensityDry The calculated sum of component ideal 

relative density values (Sum Xi * Gi) for 

a dry gas. 

IdealRelDensitySat The calculated sum of component ideal 

relative density values (Sum Xi * Gi) for 

a water saturated gas. 

IdealRelDensityWet The calculated sum of component ideal 

relative density values (Sum Xi * Gi) for 

a wet gas. 

RealRelDensityDry The real relative density (specific gravity) 

calculated for a dry gas. 

RealRelDensitySat The real relative density (specific gravity) 

calculated for a water saturated gas. 

RealRelDensityWet The real relative density (specific gravity) 

calculated for a wet gas. 

GasDensityIdealDry The gas density (lbm/cu. ft.) calculated 

for an ideal, dry gas. 

GasDensityIdealSat The gas density (lbm/cu. ft.) calculated 

for an ideal, water-saturated gas. 

GasDensityIdealWet The gas density (lbm/cu. ft.) calculated 

for an ideal, wet gas. 

GasDensityRealDry The gas density (lbm/cu. ft.) calculated 

for a real, dry gas. 

GasDensityRealSat The gas density (lbm/cu. ft.) calculated 

for a real, water-saturated gas. 

GasDensityRealWet The gas density (lbm/cu. ft.) calculated 

for a real, wet gas. 

GasCompressibilityDry The compressibility calculated for a dry 

gas. 

GasCompressibilitySat The compressibility calculated for a water 

saturated gas. 

GasCompressibilityWet The compressibility calculated for a wet 
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gas. 

TotalGPMDry The theoretical hydrocarbon liquid 

content (Gal. / 1000 cu. ft.) calculated for 

a dry gas. 

TotalGPMSat The theoretical hydrocarbon liquid 

content (Gal. / 1000 cu. ft.) calculated for 

a water saturated gas. 

TotalGPMWet The theoretical hydrocarbon liquid 

content (Gal. / 1000 cu. ft.) calculated for 

a wet gas. 

WobbeIndexDry The Wobbe Index calculated for a dry 

gas. 

WobbeIndexSat The Wobbe Index calculated for a water 

saturated gas. 

WobbeIndexWet The Wobbe Index calculated for a wet 

gas. 

TotalMWDry The total molecular weight for a dry gas. 

TotalMWSat The total molecular weight for a water 

saturated gas 

TotalMWWet The total molecular weight for a wet gas 

TotalVPDry The total vapor pressure (psia) at 100 

degrees F. 

TotalRelLiqDensityDry The total relative liquid density at 60 deg 

F. 

TotalAbsLiqDensityDry The total absolute liquid density (lbm / 

gal.).  This result is calculated from the 

sum of the individual component values, 

not by conversion from relative liquid 

density. 

TotalAbsLiqDensityBBL The total absolute liquid density (lbm / 

bbl). 

TotalVolumeCuFtGal The total volume (cu. ft. / gal.) corrected 

for base pressure. 

APIGravity The calculated API Gravity of the 

liquified product. 

Sample Information and Header Variables 

SampleName The sample name as reported by the data 

system. 

UserName The user or operator name as reported by 

the data system. 

Comments Additional Sample Information or Sample 

Notes as reported by the data system. 

MethodName The method used for acquisition by the 

data system. 

InjectionTime The date and time of the injection as 

reported by the data system. 

ReportDate The date and time that the results were 

calculated and reported. 

SettingsFile The EZReporter settings/configuration 

file used to calculate the results. 

  

SourceDataFileName The file name of the source data file used 

for acquisition as reported by the data 

system. 
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DataFile The data file to which the EZReporter 

results were saved. 

Instrument The name of the instrument used for 

acquisition as reported by the data 

system. 

ExportFile The file name of the export file. 

ExportTemplate The file name of the export template used 

to create the export file. 

ExportDirectory The directory in which the export file is 

saved. 

ResultsID The results ID from the Results Database.  

This field is only valid for sample results 

that have been retrieved from the results 

database. 

ResultStatus The result Status from the Results 

Database: 0=None, 1=Accept, 2=Reject.  

This field is only valid for sample results 

that have been retrieved from the results 

database. 

ResultComment A user-entered comment entered in the 

result confirmation screen. 

EZReporterVersion The EZReporter version number. 

SampleInfo The value of the custom sample 

information field as entered by the user.  

Usage: {SampleInfo, 1} is the value of 

custom sample information field #1. 

SampleInfoCaption The caption for the custom sample 

information field as set in the 

configuration file.  Usage: 

{SampleInfoCaption, 1} is the caption 

associated with custom sample 

information field #1. 

Tab The ASCII \"tab\" character. 

Now The current date and time as reported by 

the operating system 

StartCompLoop Start a component processing loop.  All 

template lines between {StartCompLoop} 

and {EndCompLoop} will be repeated 

once for each component in the 

configuration.  Use the component loop to 

report component-specific results. 

EndCompLoop End a component processing loop (see 

{StartCompLoop}) 

StartHeader All template lines between {StartHeader} 

and {EndHeader} will only be exported 

the first time an export file is written.  

The header lines will not be written when 

additional results are appended to an 

existing export file. 

EndHeader See {StartHeader} 

StartComment Any text between {StartComment} and 

{EndComment} will not be exported.  

Use to annotate your template file. 

EndComment See {StartComment} 
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UCase Place on a line by itself to convert all 

subsequent export lines to upper case. 

LCase Place on a line by itself to convert all 

subsequent export lines to lower case. 

NoCase Place on a line by itself to report all 

subsequent export lines in their original 

case. 

DecimalPlaces Place on a line by itself to set the number 

of decimal places that will be reported for 

calculated numeric results.  The default 

value is the number of decimal places 

specified in the Data Files configuration. 

Usage: {DecimalPlaces,3}, sets the 

number of decimal places reported to 3. 

_ Line continuation variable placed at the 

end of a line to force the next line in the 

template to be appended to the current 

line instead of to a new line. 
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Results Database Table Diagram 
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Results Database Import Template Format 

The Results Database Import Template file defines how the fields/columns in the 

comma- or tab- delimited Import Data File are mapped into the results database. 

The Import Template file is a simple text file in which “tags” (special character 

strings enclosed in curly braces) are used to define how to handle the data in the 

Import Data File. 

You must first define whether the import file is tab or comma delimited by placing 

the following tag in the template file: 

{delimiter,comma} or {delimiter,tab} 

If you don’t include the delimiter tag, then the import routine assumes a comma-

delimited file 

Next, you add a {StartColumns} tag to the template file.  Each row after the 

{StartColumns} tag corresponds to a sequential column in the import file. 

The subsequent field/column tag strings correspond exactly to the database field 

names listed below.  For fields in the “ComponentResults” Table, use the field name 

followed by the component name separated by a comma. 

As a simple example, consider the following small data set: 

 

The Import Data File for this data set would look like the following using commas as 

the delimiter: 

CAL001, 1086.2, 89.415, 4.233 

CAL002, 1087.1, 89.891, 4.562 

CAL003, 1082.3, 88.753, 4.102 

The corresponding Import Template File would be: 

{delimiter,comma} 

{StartColumns} 

{SampleName} 

{GrossHeatingValueRealDry} 

{NormAmount, Methane} 

{NormAmount, Ethane} 

 

Important: Important:  Make sure that the component names you use in the import template are 

consistent with the component names you use with your configuration files. 

 

If you want to skip a column in the Import Data File for some reason, simply insert a 

line in the template file at that location that contains no tag.  For example, if you 

don’t want to import the Gross Heating Value, then the Import Template File would 

be: 



 

  Diablo EZReporter Software Appendix    101 

{delimiter,comma} 

{StartColumns} 

{SampleName} 

 

{NormAmount, Methane} 

{NormAmount, Ethane} 

 

Comment Text 

The import routine ignores any text not contained within the curly braces.  This 

means you can add comments to the Import Template File to help you keep track of 

things.  For example it is useful to label the column to which each row corresponds 

(sometimes columns are identified by numbers and sometimes by letters, so it is 

convenient to include both – 1/A corresponds to the first column, etc.)  

{delimiter,comma} 

{StartColumns} 

1/A {SampleName} 

2/B  

3/C {NormAmount, Methane} 

4/D {NormAmount, Ethane} 

5/E 

6/F 

etc. 

In this example, columns 2, 5, and 6 would be skipped during import. 

 

SkipLines 

If the Import Data File contains “header lines” that don’t contain data at the 

beginning of the file then you can use the {SkipLines, N} tag to skip over those lines 

before starting to import data.  For example, if the Import Data File looks like this: 

Sample Name,Gross Heating Value,Methane%,Ethane% 

CAL001, 1086.2, 89.415, 4.233 

CAL002, 1087.1, 89.891, 4.562 

CAL003, 1082.3, 88.753, 4.102 

You would add a SkipLines tag that skips 1 line somewhere above {StartColumns} 

tag: 

{SkipLines,1} 

{delimiter,comma} 

{StartColumns} 

1/A {SampleName} 

2/B {GrossHeatingValueRealDry} 

3/C {NormAmount, Methane} 
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4/D {NormAmount, Ethane} 

 

Full List of Results Database Fields 

The following table lists all of the database fields that are supported by EZReporter’s 

Import Templates. 

 

Hint: Hint:  The most up to date list of import template fields can always be viewed and 

printed by clicking the “Show Variables” button on the Database Import window. 

 

 

Database Field Description 

Component Fields (ComponentResults Table) 

ComponentName The name of the component. 

PeakRT The retention time of the component as 

reported by the data system. 

PeakArea The integrated peak area of the 

component as reported by the data 

system. 

RawAmount The concentration of the component as 

reported by the data system. 

NormAmount The normalized amount of the component 

calculated by normalizing all of the raw 

component concentrations to 100%.  For 

NGA applications this is the dry 

normalized mole% (water content 

exlcuded). 

NormMolePctSat The normalized mole percent of the 

component calculated by normalizing all 

of the raw component concentrations to 

100%.  Corrected for the saturated water 

mole percent. 

NormMolePctWet The normalized mole percent of the 

component calculated by normalizing all 

of the raw component concentrations to 

100%.  Corrected for the actual water 

mole percent if it has been entered. 

NormWeightPctDry The normalized weight percent of the 

component in a dry gas. 

NormWeightPctSat The normalized weight percent of the 

component in a water-saturated gas. 

NormWeightPctWet The normalized weight percent of the 

component in a wet gas. 

NormVolumePctDry The normalized liquid volume percent of 

the component in a dry gas. 

HeatingValue The calculated gross heating value of  the 

component in an ideal, dry gas. Corrected 

for pressure base.  

HeatingValueSat The calculated gross heating value of  the 

component in an ideal, water-saturated 

gas.  Corrected for pressure base. 
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HeatingValueWet The calculated gross heating value of  the 

component in a ideal, wet gas.  Corrected 

for pressure base. 

GrossHeatingValueLBMDry The calculated gross heating value 

(BTU/lbm) of  the component in a dry 

gas. 

GrossHeatingValueLBMSat The calculated gross heating value 

(BTU/lbm) of  the component in a water-

saturated gas. 

GrossHeatingValueLBMWet The calculated gross heating value 

(BTU/lbm) of  the component in a wet 

gas. 

NetHeatingValueLBMDry The calculated net heating value 

(BTU/lbm) of  the component in a dry 

gas. 

NetHeatingValueLBMSat The calculated net heating value 

(BTU/lbm) of  the component in a water-

saturated gas. 

NetHeatingValueLBMWet The calculated net heating value 

(BTU/lbm) of  the component in a wet 

gas. 

GrossHeatingValueGalDry The calculated gross heating value 

(BTU/gal.) of  the component in a dry 

gas. 

GrossHeatingValueLBMDry The calculated gross heating value 

(BTU/lbm) of  the component in a dry 

gas. 

RelativeDensity The calculated relative density (Xi * Gi) 

of the current component in a dry gas. 

RelativeDensitySat The calculated relative density (Xi * Gi) 

of the current component in a water-

saturated gas. 

RelativeDensityWet The calculated relative density (Xi * Gi) 

of the current component in a wet gas. 

GasDensityIdealDry The calculated ideal gas density 

(lbm/cu.ft.) of this component in a dry 

gas. 

GasDensityIdealSat The calculated ideal gas density 

(lbm/cu.ft.) of this component in a water-

saturated gas. 

GasDensityIdealWet The calculated ideal gas density 

(lbm/cu.ft.) of this component in a wet 

gas. 

Compressibility The calculated compressibility (Xi * bi) 

of the current component in a dry gas. 

CompressibilitySat The calculated compressibility (Xi * bi) 

of the current component in a water 

saturated gas. 

CompressibilityWet The calculated compressibility (Xi * bi) 

of the current component in a wet gas. 

GPM The calculated GPM (Gal. per 1000 cu. 

ft.) of the component in a dry gas.  

Corrected for pressure base. 

GPMSat The calculated GPM (Gal. per 1000 cu. 
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ft.) of the component in a water saturated 

gas.  Corrected for pressure base. 

GPMWet The calculated GPM (Gal. per 1000 cu. 

ft.) of the component in a wet gas.  

Corrected for pressure base. 

MolecularWeightDry The calculated molecular weight of the 

component in a dry gas. 

MolecularWeightSat The calculated molecular weight of the 

component in a water saturated gas. 

MolecularWeightWet The calculated molecular weight of the 

component in a wet gas. 

VaporPressureDry The calculated vapor pressure of the 

component in a dry gas at 100 degrees F. 

RelativeLiquidDensityDry The calculated relative liquid density of 

the component in a dry gas. 

AbsoluteLiquidDensityDry The calculated liquid density (lbm/gal.) of 

the component in a dry gas. 

Total/Summary Fields (SampleResults and NGAResults Tables) 

TotalRawAmount The total raw amount, including water if 

it has been entered. 

TotalRawMolePctDry The total raw mole percent (excluding 

water) 

TotalNormAmount The total normalized amount (should 

always be 100%) 

TotalNormMolePctDry The total normalized mole pct for a dry 

gas (should always be 100%) 

TotalNormMolePctSat The total normalized mole pct for a 

water-saturated gas (should always be 

100%) 

TotalNormMolePctWet The total normalized mole pct for a wet 

gas (should always be 100%) 

TotalNormWeightPctDry The total normalized weight percent for a 

dry gas (should always be 100%) 

TotalNormWeightPctSat The total normalized weight percent for a 

water a saturated gas (should always be 

100%) 

TotalNormWeightPctWet The total normalized weight percent for a 

wet gas (should always be 100%) 

TotalNormVolumePctDry The total normalized liquid volume 

percent for a dry gas (should always be 

100%) 

SumCompressibility The calculated sum of component 

compressibility values (Sum Xi * bi) for a 

dry gas. 

SumCompressibilitySat The calculated sum of component 

compressibility values (Sum Xi * bi) for a 

water saturated gas. 

SumCompressibilityWet The calculated sum of component 

compressibility values (Sum Xi * bi) for a 

wet gas. 

PressureBase The Pressure Base used in the 

calculations. 

FlowingTemperature The flowing temperature in degrees F. 

FlowingPressure The flowing pressure in psia. 
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WaterMoleFractionWet The water mole fraction if it has been 

entered or has been calculated by the 

water content correlation. 

WaterMoleFractionSat The water mole fraction calculated for 

saturated conditions at the base 

temperature and base pressure. 

GrossHeatingValueIdealDry The total gross heating value for an ideal, 

dry gas 

GrossHeatingValueIdealSat The total gross heating value for an ideal, 

water saturated gas. 

GrossHeatingValueIdealWet The total gross heating value for an ideal, 

wet gas. 

GrossHeatingValueRealDry The total gross heating value for a real, 

dry gas 

GrossHeatingValueRealSat The total gross heating value for a real, 

water saturated gas. 

GrossHeatingValueRealWet The total gross heating value for a real, 

wet gas. 

GrossHeatingValueLBMDry The total gross heating value (BTU/lbm) 

for a dry gas. 

GrossHeatingValueLBMSat The total gross heating value (BTU/lbm) 

for a water-saturated gas. 

GrossHeatingValueLBMWet The total gross heating value (BTU/lbm) 

for a wet gas. 

GrossHeatingValueGalDry The total gross heating value (BTU/gal.) 

for a dry gas. 

NetHeatingValueIdealDry The total net heating value (BTU/cu.ft.) 

for an ideal, dry gas. 

NetHeatingValueIdealSat The total net heating value (BTU/cu.ft.) 

for an ideal, water saturated gas. 

NetHeatingValueIdealWet The total net heating value (BTU/cu.ft.) 

for an ideal, wet gas. 

NetHeatingValueRealDry The total net heating value (BTU/cu.ft.) 

for a real, dry gas 

NetHeatingValueRealSat The total net heating value (BTU/cu.ft.) 

for a real, water saturated gas. 

NetHeatingValueRealWet The total gross heating value (BTU/cu.ft.) 

for a real, wet gas. 

NetHeatingValueLBMDry The total net heating value (BTU/lbm) for 

a dry gas. 

NetHeatingValueLBMSat The total net heating value (BTU/lbm) for 

a water-saturated gas. 

NetHeatingValueLBMWet The total net heating value (BTU/lbm) for 

a wet gas. 

SumRelativeDensity The calculated sum of component ideal 

relative density values (Sum Xi * Gi) for 

a dry gas. 

SumRelativeDensitySat The calculated sum of component ideal 

relative density values (Sum Xi * Gi) for 

a water saturated gas. 

SumRelativeDensityWet The calculated sum of component ideal 

relative density values (Sum Xi * Gi) for 

a wet gas. 

RealRelativeDensityDry The real relative density (specific gravity) 
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calculated for a dry gas. 

RealRelativeDensitySat The real relative density (specific gravity) 

calculated for a water saturated gas. 

RealRelativeDensityWet The real relative density (specific gravity) 

calculated for a wet gas. 

GasCompressibilityDry The compressibility calculated for a dry 

gas. 

GasCompressibilitySat The compressibility calculated for a water 

saturated gas. 

GasCompressibilityWet The compressibility calculated for a wet 

gas. 

GasDensityIdealDry The gas density (lbm/cu. ft.) calculated 

for an ideal, dry gas. 

GasDensityIdealSat The gas density (lbm/cu. ft.) calculated 

for an ideal, water-saturated gas. 

GasDensityIdealWet The gas density (lbm/cu. ft.) calculated 

for an ideal, wet gas. 

GasDensityRealDry The gas density (lbm/cu. ft.) calculated 

for a real, dry gas. 

GasDensityRealSat The gas density (lbm/cu. ft.) calculated 

for a real, water-saturated gas. 

GasDensityRealWet The gas density (lbm/cu. ft.) calculated 

for a real, wet gas. 

SumGPM The theoretical hydrocarbon liquid 

content (Gal. / 1000 cu. ft.) calculated for 

a dry gas. 

TotalGPMSat The theoretical hydrocarbon liquid 

content (Gal. / 1000 cu. ft.) calculated for 

a water saturated gas. 

TotalGPMWet The theoretical hydrocarbon liquid 

content (Gal. / 1000 cu. ft.) calculated for 

a wet gas. 

WobbeIndexDry The Wobbe Index calculated for a dry 

gas. 

WobbeIndexSat The Wobbe Index calculated for a water 

saturated gas. 

WobbeIndexWet The Wobbe Index calculated for a wet 

gas. 

TotalMolecularWeightDry The total molecular weight for a dry gas. 

TotalMolecularWeightSat The total molecular weight for a water 

saturated gas 

TotalMolecularWeightWet The total molecular weight for a wet gas 

TotalVaporPressureDry The total vapor pressure (psia) at 100 

degrees F. 

TotalRelativeLiquidDensityDry The total relative liquid density at 60 deg 

F. 

TotalAbsoluteLiquidDensityDry The total absolute liquid density (lbm / 

gal.).  This results is calculated from the 

sum of the individual component values, 

not by conversion from relative liquid 

density. 

TotalAbsoluteLiquidDensityBBL The total absolute liquid density (lbm / 

bbl). 

TotalVolumeCuFtGal The total volume (cu. ft. / gal.) corrected 
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for base pressure. 

APIGravity The calculated API Gravity of the 

liquified product. 

Sample Information Fields (SampleResults Table) 

SampleName The sample name as reported by the data 

system. 

OperatorName The user or operator name as reported by 

the data system. 

SampleComments Additional Sample Information or Sample 

Notes as reported by the data system. 

MethodName The method used for acquisition by the 

data system. 

InjectionDate The date and time of the injection as 

reported by the data system. 

ReportDate The date and time that the results were 

calculated and reported. 

ConfigurationFile The EZReporter settings/configuration 

file used to calculate the results. 

SourceDataFile The file name of the source data file used 

for acquisition as reported by the data 

system. 

BTUDataFile The data file to which the EZReporter 

results were saved. 

InstrumentName The name of the instrument used for 

acquisition as reported by the data 

system. 

ResultsID The results ID from the Results Database.  

This field is only valid for sample results 

that have been retrieved from the results 

database. 

ResultStatus The result Status from the Results 

Database: 0=None, 1=Accept, 2=Reject.  

This field is only valid for sample results 

that have been retrieved from the results 

database. 

ResultComment A user-entered comment entered in the 

result confirmation screen. 

Calculated Result Formula Builder Operators 
The following table lists the arithmetic operators that can be used along with Result 

Variables to create a Calculated Result custom formula using the Formula Builder 

tool.  See “Creating a Custom Formula using the Formula Builder” on page 39 for 

more information on custom formulas. 

 

Operator / Function Description Note 

+ addition   

- subtraction   

* multiplication   
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Operator / Function Description Note 

/ division 35/4 = 8.75 

% percentage 35% = 0.35 

\ integer division 35\4 = 8 

^ raise to power 3^1.8 = 7.22467405584208  (°) 

>  greater than return 1 (true)   0 (false) 

>= equal or greater than return 1 (true)   0 (false) 

<  less than return 1 (true)   0 (false) 

<= equal or less than return 1 (true)   0 (false) 

= equal return 1 (true)   0 (false) 

<>  not equal return 1 (true)   0 (false) 

tan(x) tangent 

argument (in radians)  x k*/2  

with k =  1,  2… 

atn(x) inverse tangent atn(pi/4) = 1 

abs(x) absolute value abs(-5)= 5 

sin(x) sin argument in radians 

cos(x) cosine argument in radians 

exp(x) exponential exp(1) = 2.71828182845905 

log(x) logarithm natural argument x>0 

logN(x,n) N-base logarithm logN(16,2) = 4 

sqr(x) square root 
sqr(2) =1.4142135623731,  also 
2^(1/2) 

int(x) integer part int(-3.8) = −4 

fix(x) integer part fix(-3.8) = 3 

dec(x) decimal part dec(-3.8) = -0.8 

rnd(x) random 
returns a random number 
between x and 0 

sgn(x) sign 

returns 1 if x >0 , 0 if x=0, -1 if 
x<0 

min(a,b,...) minimum min(13,24) = 13 

max(a,b,...) maximum max(13,24) = 24 

round(x,d) 
round a number with d 

decimal round(1.35712, 2) = 1.36   

Sum(a,b,...) Sum sum(8,9,12,9,7,10) = 55 
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Operator / Function Description Note 

Mean(a,b,...) Arithmetic mean 
mean(8,9,12,9,7,10) = 
9.16666666666667 

Meanq(a,b,...) Quadratic mean 
meanq(8,9,12,9,7,10) = 
9.30053761886914 

Meang(a,b,...) Arithmetic mean 
meang(8,9,12,9,7,10) = 
9.03598945281812 

Var(a,b,...) Variance 
var(1,2,3,4,5,6,7) = 
4.66666666666667 

Varp(a,b,...) Variance pop. varp(1,2,3,4,5,6,7) = 4 

Stdev(a,b,...) Standard deviation 
Stdev(1,2,3,4,5,6,7) = 
2.16024689946929 

Stdevp(a,b,...) Standard deviation pop. Stdevp(1,2,3,4,5,6,7) = 2 

 





 

  Diablo EZReporter Software Index    111 

Index 

A 

Activating your License 6 

Adding Calculated Results to the Configuration and 

Report 38 

Adding new components 26 

Adding or Editing Monitored Parameters 43 

Adding Results to the Database 81 

Additional Extended Fractions 69 

Air Summation Factor 59 

Alarm 2, 14, 40, 43, 44, 49 

Append Additional Text 30 

Appendix 85 

Auto-add All Components 41 

Auto-Generated Data File Naming Options 33 

Automatic Data Processing and Reporting 52 

Automatic file saving 20, 33 

B 

Base Pressure 59 

Base Temperature 59 

Batch Processing Multiple Results 77 

C 

Calculated Result Formula Builder Operators 107 

Calculated Results 38 

Calculation Settings 27 

Changing the component order 26, 65 

Changing the Display Order of Parameters 41 

Changing the order of Sample Information Fields 35 

Clearing the table 27 

Cloning Parameters 41 

Comparing Results 79 

Component Amount Precision 28 

Component Name 25, 54 

Component physical properties 55 

Component Settings for Natural Gas Analysis 54 

Component Summary 12 

Component Table Context Menu 27 

Components 24 

Configuring Natural Gas Analysis 54 

Configuring the Base Software Module 24 

Configuring the EZReporter Component List 64 

Configuring the Results Database 71 

Context Menu 32, 56 

Creating a Custom Formula using the Formula Builder 

39 

Cu. Ft. / lb - mol of Gas 59 

Customizing the Report 13 

D 

Data Export 35 

Data Files 32 

Data Processing and Reporting 51 

Database Maintenance 72 

Database Status 72 

Default Data Directory 32 

Default Value 34 

Deleting Components 65 

Deleting existing components 26 

Deleting Results from the Database 80 

Disable Natural Gas Analysis Calculations and 

Reporting 58 

Disabling NGA Calculations 8 

Disclaimer 7 

Duplicating Components 65 

E 

Editing the Default Configuration 63 

Entering custom sample information: 35 

Export Directory 36 

Export File 36 

Export Options 36 

Export Template File 36 

Export Template Format 86 

Export Variable Format Strings and Scale Factors 90 

Extended - Combined Report 62 

Extended - Combined Report with Raw Amount 

Correction 62 

Extended - Separate Report 62 

Extended Fraction Component Range 67 

Extended Fraction Raw Amount Correction 69 

Extended Fraction Report Format 67 

Extended Report Control 67 

Extended Report Format 68 

EZReporter Data File Format 85 

EZReporter Software Overview 1 

F 

File Format 33 

File Menu 22 

File Naming Options 20 



 

112    Index   Diablo EZReporter Software 

Finding Results in the Database 78 

Fixed Alarm Limits 46 

Format 31 

Full List of Export Template Variables 91 

Full List of Results Database Fields 102 

G 

Generating a Report for a Selected Result 76 

Getting Started 11 

Gross Heating Value 3, 85 

H 

Help Menu 23 

Hexanes Plus 56 

History Plot 23, 44 

I 

Importing Results into the Database 81 

Installing the Software 4 

Internal Standard Amount Mapping 28 

Introduction 1 

L 

Load and Edit the Configuration File 16 

M 

Managing Configuration Files 24 

Manual Amount/Mole% Entry 26 

Manual Data Processing and Reporting 51 

Molar Mass Ratio 3, 85 

Monitored parameters 29 

N 

Natural Gas Analysis 54 

Natural Gas Analysis Calculations 7 

Natural Gas Analysis Settings 57 

NGA License Status 58 

NGA Physical Property Base Data Source 58 

NGL/Extended Fraction Reporting 61 

Notes for BTU Calculator Users 4 

Numeric Sample Information Fields 34 

O 

Overview of NGL Configuration Window 66 

Overview of the Results Database 70 

P 

Parameter Alarms 44 

Parameter History 49 

Parameter Options 40 

PDF File Control 30 

Physical Property Transfer Options 56 

Pressure Base 7, 13, 17, 18, 19, 20, 59 

Q 

Quick Start Instructions 16 

R 

Raw Component Amount Units 61 

Real Relative Density 3 

Recall Last Value 34 

Relative Alarm Limits 46 

Renaming Components 65 

Repeatability and Reproducibility Limits 25 

Report 34 

Report - Control 29 

Report - Customize 31 

Report - Titles 30 

Report Control 29 

Report Margins 29 

Resources 8 

Results Database Import Template Format 100 

Results Database Table Diagram 99 

Results Processing 72 

Results Summary 13 

Rounding 8 

Running the Software 22 

S 

Sample History Alarm Limits 48 

Sample Info 33 

Sample Information 12 

Sample Name Options 33 

Sample Results Summary Table 74 

Sample-Specific Configuration Processing 52 

Selected Sample Detail Tables 75 

Selecting and Deselecting Results 76 

Selecting the NGL Calculation and Reporting Method 

62 

Set the Data File Preferences 20 

Set the Report Preferences 20 

Set up your Chromatography Data System 21 

Setting Monitored Parameter Options 41 

Show Template Variables 37 

Software License and Registration 5 

Specify Other NGA Calculation Parameters 20 

Standard Component Physical Properties 55 

Summary of Export Template Variables 89 

Summation Factor 3, 59, 85 

System Requirements 4 



 

  Diablo EZReporter Software Index    113 

T 

Technical Support 6 

Text Alarms 47 

The Main Menu 22 

The Parameter History Window 14 

The Parameter Monitor 49 

The Parameter Monitor Window 14 

The Results Database 70 

The Results Database Window 15, 73 

The Sample Results Window 11 

Tools Menu 23 

U 

Undoing changes to the component list 27 

Unknown Component Dialog Box 56 

Upgrading from the Diablo BTU Calculator Software 5 

Upgrading the Results Database Format 82 

Using Monitored Parameters and History Plots 49 

Using the Results Database 76 

V 

Volume Factor 3 

W 

Water Calculations 8 

Water Settings for "Saturated" and "Wet" Calculations 

60 

 

 


	Diablo Analytical EZReporter Software
	Introduction
	EZReporter Software Overview
	Notes for BTU Calculator Users

	System Requirements
	Installing the Software
	Upgrading from the Diablo BTU Calculator Software

	Software License and Registration
	Activating your License

	Technical Support
	Natural Gas Analysis Calculations
	Disclaimer
	Pressure Base

	Rounding
	Water Calculations
	Disabling NGA Calculations
	Resources


	Getting Started
	The Sample Results Window
	Sample Information
	Component Summary
	Results Summary
	Customizing the Report

	The Parameter Monitor Window
	The Parameter History Window
	The Results Database Window
	Quick Start Instructions
	Load and Edit the Configuration File
	Specify Other NGA Calculation Parameters
	Set the Report Preferences
	Set the Data File Preferences
	Automatic file saving
	File Naming Options

	Set up your Chromatography Data System


	Running the Software
	The Main Menu
	File Menu
	Tools Menu
	Help Menu

	Configuring the Base Software Module
	Managing Configuration Files
	Components
	Component Name
	Repeatability and Reproducibility Limits
	Manual Amount/Mole% Entry
	Adding new components
	Deleting existing components
	Changing the component order
	Clearing the table
	Undoing changes to the component list
	Component Table Context Menu

	Calculation Settings
	Component Amount Precision
	Internal Standard Amount Mapping

	Report - Control
	Report Control
	Monitored parameters
	Report Margins
	PDF File Control
	Append Additional Text

	Report – Titles
	Report - Customize
	Format
	Context Menu

	Data Files
	Default Data Directory
	Automatic File Saving
	Auto-Generated Data File Naming Options
	Sample Name Options
	File Format

	Sample Info
	Default Value
	Numeric Sample Information Fields
	Recall Last Value
	Report
	Changing the order of Sample Information Fields
	Entering custom sample information:

	Data Export
	Export Options
	Export Template File
	Export Directory
	Export File
	Show Template Variables

	Calculated Results
	Adding Calculated Results to the Configuration and Report
	Creating a Custom Formula using the Formula Builder

	Parameter Options
	Changing the Display Order of Parameters
	Cloning Parameters
	Auto-add All Components

	Setting Monitored Parameter Options
	Adding or Editing Monitored Parameters
	Parameter Alarms
	Fixed Alarm Limits
	Relative Alarm Limits
	Text Alarms
	Sample History Alarm Limits


	Using Monitored Parameters and History Plots
	The Parameter Monitor
	Parameter History

	Data Processing and Reporting
	Manual Data Processing and Reporting
	Automatic Data Processing and Reporting
	Sample-Specific Configuration Processing


	Natural Gas Analysis
	Configuring Natural Gas Analysis
	Component Settings for Natural Gas Analysis
	Component Name
	Component physical properties

	Standard Component Physical Properties
	Context Menu
	Physical Property Transfer Options
	Unknown Component Dialog Box

	Natural Gas Analysis Settings
	NGA License Status
	Disable Natural Gas Analysis Calculations and Reporting
	NGA Physical Property Base Data Source
	Base Temperature
	Base Pressure
	Air Summation Factor
	Cu. Ft. / lb – mol of Gas
	Water Settings for "Saturated" and "Wet" Calculations
	Raw Component Amount Units


	NGL/Extended Fraction Reporting
	Selecting the NGL Calculation and Reporting Method
	Extended – Separate Report
	Extended – Combined Report
	Extended – Combined Report with Raw Amount Correction
	Editing the Default Configuration
	Configuring the EZReporter Component List
	Deleting Components
	Renaming Components
	Duplicating Components
	Changing the Component Order

	Overview of NGL Configuration Window
	Extended Report Control
	Extended Fraction Report Format
	Extended Fraction Component Range
	Extended Report Format
	Extended Fraction Raw Amount Correction

	Additional Extended Fractions


	The Results Database
	Overview of the Results Database
	Configuring the Results Database
	Database Status
	Database Maintenance
	Results Processing

	The Results Database Window
	Sample Results Summary Table
	Selected Sample Detail Tables

	Using the Results Database
	Selecting and Deselecting Results
	Generating a Report for a Selected Result
	Batch Processing Multiple Results
	Finding Results in the Database
	Comparing Results
	Deleting Results from the Database
	Adding Results to the Database
	Importing Results into the Database

	Upgrading the Results Database Format

	Appendix
	EZReporter Data File Format
	Export Template Format
	Summary of Export Template Variables
	Export Variable Format Strings and Scale Factors
	Full List of Export Template Variables


	Results Database Table Diagram
	Results Database Import Template Format
	Full List of Results Database Fields

	Calculated Result Formula Builder Operators

	Index

